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About this book

DB2 OLAP Server is based on products from ShowCase (A division of SPSS
Inc.) and Hyperion Solutions Corporation. This book was written by IBM and
ShowCase and is intended to be used with books and online help written by
ShowCase and Hyperion. You will see references to Hyperion and Hyperion’s
products in the interface and throughout the Hyperion books. Only the
relevant Hyperion books are included with the DB2 OLAP Server book; this
book and the exceptions are listed in “Publications” on page vi.

This book combines and summarizes information from the following
ShowCase and Hyperion books, and therefore these books are not included in
the IBM product:
v Essbase/400 6.5 Installation Guide

v ShowCase 6.5 Installation Guide

v Hyperion Essbase 6.5 New Features

v Hyperion Essbase 6.5 Installation Guide

v Hyperion Essbase 6.5 Installation Checklist

v Essbase Integration Services 6.5 New Features

v Essbase Integration Services 6.5 Installation Guide

Who should read this book

Read this book if you are a DB2 OLAP Server administrator who is
responsible for:
v Installing and configuring DB2 OLAP Server.
v Designing and creating OLAP applications and multidimensional databases

using DB2 OLAP Server.
v Setting up security for DB2 OLAP Server.
v Maintaining OLAP applications and multidimensional databases that are

migrated to or created using DB2 OLAP Server.

As the DB2 OLAP Server administrator, you should have experience in
networking and system administration, and should understand the analytical
requirements of the users who will use the applications created with DB2
OLAP Server.
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Publications

This section lists books that are included with DB2 OLAP Server for iSeries
and its add-on products. DB2 OLAP Server users can find these books from
the Start > Programs > IBM DB2 OLAP Server 8.1 – iSeries >
Documentation information map. The books are stored in the
x:\ibm\db2olap\docs directory, where x:\ibm\db2olap is the directory in
which you installed DB2 OLAP Server workstation applications.

If you choose the Typical option during installation, DB2 OLAP Server installs
only a subset of the documentation. To install all the documentation, choose
Custom during installation and select the books you want.

Table 1 lists the publications that are included with the DB2 OLAP Server for
iSeries base product.

Table 1. DB2 OLAP Server Publications

Publication Name Description

Installation Guide for iSeries
(GC18–7225)

Describes how to install and configure DB2 OLAP
Server for iSeries, including Integration Server and
Builder. This book combines the ShowCase and
Hyperion installation books with new information
from IBM.

Administrator’s Guide for OLAP
on iSeries (SC18–7226)

Provides iSeries database administrators with
information about configuring and maintaining DB2
OLAP Server for iSeries.

Showcase calls this book Essbase/400 6.5
Administrator’s Guide

Administrator’s Guide for Builder
on iSeries (SC18–7227)

Provides iSeries database administrators with
information about configuring and the Builder
add-on product for DB2 OLAP Server for iSeries

Showcase calls this book ShowCase 6.5 Administrator’s
Guide.

Upgrade Guide for iSeries Includes migration and coexistence tips for DB2
OLAP Server for iSeries. This book is available only
online from:

www.ibm.com/software/data/db2/db2olap/library.html

Installation Guide (SC27–1228) Explains how to install and configure DB2 OLAP
Server on UNIX and Windows. This book is included
for reference only; you should not need to use this
book for DB2 OLAP Server on iSeries.

Quick Path (SC18-7000) Summarizes the major tasks of creating OLAP
applications using DB2 OLAP Server.
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Table 1. DB2 OLAP Server Publications (continued)

Publication Name Description

OLAP Miner User’s Guide
(SC27-1611)

Explains how to use DB2 OLAP Server Miner, a
no-charge feature that combines the powerful IBM
data mining technologies with OLAP technologies.

Spreadsheet Add-in User’s Guide
for Excel (SC27-1232)

Explains how to use the Spreadsheet Add-in with
Microsoft Excel for Windows to analyze data.

Spreadsheet Add-in User’s Guide
for 1-2-3 (SC27-1231)

Explains how to use the Spreadsheet Add-in with
Lotus 1-2-3 for Windows to analyze data.

Database Administrator’s Guide,
Volumes 1, 2, and 3 (SC18-7001,
SC18-7002, and SC18-7003,
respectively)

Provides administrators with strategies and
techniques to implement, design, build, and maintain
an optimized multidimensional database. Provides
instructions for how to design and build a security
system. Provides instructions for how to load,
calculate, and report your data. Also provides
instructions for performing tasks using the
Application Manager.

MaxL User’s Guide (SC18-7005) Describes how to use MaxL, the multidimensional
database access language for DB2 OLAP Server.
MaxL is a flexible way to automate Hyperion Essbase
administration and maintenance tasks.

SQL Interface Guide (SC18-7004) Explains how to load data from SQL, relational, and
flat-file data sources. This book is not used with DB2
OLAP Server for iSeries.

Technical Reference Provides reference about writing formulas, calculation
scripts, report scripts, MaxL statements, and
custom-defined macros and functions. It also includes
ESSBASE.CFG settings and ESSCMD commands.

API Reference Provides reference information for functions that are
available through the Application Programming
Interface.

Message Reference Describes common messages in DB2 OLAP Server
and their causes and solutions.

Integration Server Administration
Guide (SC27-1227)

Explains how to use the Administration Manager
component of the DB2 OLAP Integration Server.

Integration Server Data
Preparation Guide (SC18-7006)

Explains how to prepare relational data for use with
the DB2 OLAP Integration Server.

The DB2 OLAP Server publications are also available online at:
www.ibm.com/software/data/db2/db2olap/library.html

Several IBM Redbooks about DB2 OLAP Server and related topics are
available. To view OLAP Redbooks online, visit the IBM Redbook Web site at:
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www.redbooks.ibm.com

Service and additional support

DB2 OLAP Server for iSeries is an IBM product and is serviced by IBM. The
documentation from ShowCase and Hyperion includes references to service
from ShowCase or Hyperion; disregard those references.

The Web site for DB2 OLAP Server and its features offers an extensive
selection of hints, tips, frequently asked questions, and more information, as
well as FixPaks:
www.ibm.com/software/data/db2/db2olap/support.html
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Chapter 1. What’s new in Version 8.1

This chapter describes new enhancements to DB2 OLAP Server and DB2
OLAP Integration Server since the previous version.

What’s new in DB2 OLAP Server for iSeries

This section provides an overview of significant changes in DB2 OLAP Server
Version 8.1.

DB2 OLAP Integration Server
DB2 OLAP Integration Server enables you to map and transfer the
relevant data in a relational database to an OLAP database. It includes
a set of graphical tools and a shared, enterprise OLAP metadata
datalog. It enables you to:
v Create a logical OLAP model from relational tables, views, and

columns
v Add structures and rules to the OLAP model
v Create and populate an OLAP cube from relational sources
v Drill from an OLAP cube into data stored in relational databases.

Hybrid Analysis, a new feature in DB2 OLAP Integration Server 8.1,
offers you a method of virtually extending your OLAP cube into
relational database. See 11 for more information.

OLAP Miner for Deviation Discovery
DB2 OLAP Server Miner is a no charge feature of DB2 OLAP Server.
OLAP Miner combines the powerful IBM data mining technologies
with OLAP technologies.

OLAP Miner enables you to examine your OLAP cubes
(multidimensional databases) more thoroughly and easily by finding
atypical or deviant values automatically. Instead of searching through
your data manually to find data values that might be higher or lower
than you expected, OLAP Miner can do this work for you. The OLAP
Miner algorithm is optimized so that it can be deployed on large
OLAP cubes.

You can search specific areas (subcubes) of your cubes by creating
deviation detection definitions, which specify the way in which OLAP
Miner examines the data that you selected for the subcube. OLAP
Miner provides an easy-to-use wizard that helps you create deviation
detection definitions. After you create and run a deviation detection
definition, OLAP Miner applies an algorithm to the data to find

© Copyright IBM Corp. 1998, 2002 1



deviations. Then you can view a simple list of deviations or bring up
the Deviation Viewer, from which you can see the deviations in the
context with other surrounding values. You can also view deviations
in a standard spreadsheet application.

OLAP Miner was introduced in FixPak 7 of Version 7.1.

Relational Storage Manager is no longer available
Starting in Version 8.1, the Relational Storage Manager (RSM) is
withdrawn from DB2 OLAP Server. Applications created using the
RSM in previous versions must be migrated to the Multidimensional
Storage Manager (MSM) before installing Version 8.1. See “Migrate
from RSM to MSM before upgrading to Version 8.1” on page 25 for
more information.

The following changes are specific to Release 6.5 of Essbase/400 from
ShowCase:

Enhanced STRESSSVR and ENDESSSVR Commands
The commands to start and end the Essbase/400 OLAP Server
(STRESSSVR and ENDESSSVR) have been enhanced with the
functionality to start and end the Essbase/400 Integration Server (EIS)
and the Essbase/400 Enterprise Server (EES). For instructions, see the
Administrator’s Guide for OLAP on iSeries (Essbase/400 6.5 Administrator’s
Guide).

MaxL vs. ESSCMD
In this release, both MaxL and ESSCMD are supported. However, the
Multidimensional Access Language (MaxL) is quickly becoming the
primary linguistic interface for interacting with DB2 OLAP Server.
Users are urged to start using MaxL in place of ESSCMD.

MaxL I/O Settings Support
The iSeries supports only buffered I/O access.

MaxL Character Support
If MaxL statements include invariant characters, such as:
] [

then configure your iSeries with CCSID 37. If you do not configure
with CCSID 37, then use MaxL on Windows instead of MaxL on
iSeries.

LDAP Not Supported
Because LDAP is not supported, there is no support for external
authentication. Attempts to create an external user will result in
Essbase error number 1051148:
Local/ESSBASE0///Error(1051148)
User [...]’s External Authentication Protocol [...] Not Loaded

2 DB2 OLAP Server Installation Guide for iSeries



The following changes are specific to Release 6.5 of Essbase OLAP Server
from Hyperion:

Hybrid Analysis for relational data support
DB2 OLAP Server supports Hybrid Analysis, a method of accessing
the lowest level members of an OLAP database from a relational
database. This relational data is not physically loaded into DB2 OLAP
Server. The data is mapped to the appropriate OLAP hierarchies.

Use DB2 OLAP Integration Server for iSeries (EIS) and the Hybrid
Analysis manager to create applications that access relational data
using Hybrid Analysis. The manager generates queries dynamically
against the relational source, and runs as part of the OLAP Server.

For more information about how to use Hybrid Analysis, see these
documents:
v Technical Reference in the docs directory, in the Report Writer and

Configuration Settings sections for information about Hybrid
Analysis commands and settings

v EIS online help and Intelligent Help
v Application Manager help: Database Settings, Storage Tab, Access

Mode

Parallel Calculation
In addition to the standard means of performing a calculation, where
each task is performed in sequence or serially, DB2 OLAP Server now
supports parallel calculation.

If you enable parallel calculation, DB2 OLAP Server analyzes all the
tasks in a calculation pass and breaks them down into subtasks. The
subtasks that can run independently of each other are scheduled to
run simultaneously on up to four threads, each on a separate CPU.

See the Technical Reference, which entries in the configuration setting
and calculation commands sections. You can enable and adjust parallel
calculation by adding CALCPARALLEL (and optionally
CALCTASKDIMS) to your essbase.cfg configuration file, or you can
issue the calculation commands SETCALCPARALLEL (and optionally
SET CALCTASKDIMS).

Simulated Calculations
Use the ESSCMD command SET MSG ONLY to perform simulated
calculations. These simulated calculations can help you to select dense
and sparse settings for the dimensions in your outline. See the
Technical Reference in the docs directory for more information.

Empty Outline Support in Dimension Building
DB2 OLAP Server can now build dimensions in empty outline files.
When a new database is created, DB2 OLAP Server creates an empty
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outline file. In previous releases, before building outlines from a data
source, users had to add at least one dimension member to the empty
outline manually. Now, DB2 OLAP Server no longer requires the
manual step.

Substitution Variable Support in SQL Interface
You can use substitution variables in SQL strings, similar to
substitution variable use in report scripts and calculation scripts. For
details, see the SQL Interface Guide, available in PDF or HTML.

Connection Information Available
Client API programs can now access information about users
currently connected to Essbase. The new function EssListLogins()
provides a count of the users logged in to a specified connection and
returns information on the connected client names and IP addresses.

Server Log Enhancements
Messages in the server log dealing with user logins and security
changes now include additional details:
v The user name of anyone entering an incorrect password or

changing a password
v The IP address of the computer on which a user logs in
v The user name and group name when the user or group is deleted

In addition, DB2 OLAP Server logs additional security activities in the
server log, including the name of the user and group being changed
and the user performing the change:
v Adding users to groups and removing users from groups
v Granting and revoking database and application access

I/O Setting Changes
Previously, configuration setting DIRECTIO controlled the default
mode of I/O access at the server level. Now, DIRECTIO controls only
the I/O mode used for databases when they are created. To change
the I/O mode for an individual database, use Application Manager,
and navigate to the Database Settings window, Storage tab.

Correct Structure Alignment
Header files contain new information and structures that enable DB2
OLAP Server to run more quickly and efficiently. You need not do
anything for new or upgraded installations, the changes are made
automatically. Two header files, esbapi.h and esbotl.h, are no longer
needed, and therefore no longer shipped with Essbase. One new
header file, esstsa.h, has been added.

New Error Message Documentation
Help for error messages are now available from the Information Map,
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which you can launch from the Start > Programs > IBM DB2 OLAP
Server 8.1 > Documentation menu.

The following changes are specific to Release 6.2 of Hyperion Essbase OLAP
Server.

Application and database migration across OLAP Servers
You can migrate applications and databases from one server to
another, regardless of platform. When you migrate, you can also
migrate user/group security, including filter associations.

User and group migration across OLAP Servers
You can migrate DB2 OLAP Server users and groups from one server
to another, regardless of platform. You can migrate individual users
and groups, or you can migrate multiple users or multiple groups at
one time.

Password propagation
You can change a password and then propagate that password to
other OLAP Servers.

Single sign-on to DB2 OLAP Server enterprise environment
When you log in to Administration Services, the Administration
Server handles your connections to OLAP Servers, applications, and
databases.

Log analysis
Using Log Analyzer, you can filter, search, and analyze OLAP Server
logs and application logs.

New MaxL Script Editor
A new MaxL Script Editor is integrated with the Administration
Services Console. From this editor, you can create, edit, save, and
execute MaxL statements and scripts. You can also use the editor to
type and execute MaxL statements interactively, or to perform one
DB2 OLAP Server operation at a time. Results from MaxL statements
are displayed within the editor.

Background processing
You can execute calculations in the background while performing
other tasks. You can also exit the console while the process continues
to run. A message panel in the console window notifies you when the
process has completed.

Printing DB2 OLAP Server information
You can print the contents of many windows in the console. For
example, you can print the contents of the Database Properties
window or the Log Analyzer window.
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Graphical view of DB2 OLAP Server
You can use the Graphical Enterprise view in the console to operate
directly on DB2 OLAP Server objects and to create custom views of
the DB2 OLAP Server environment.

Parallel data load
DB2 OLAP Server now supports parallel data loading. You can specify
the number of data processing threads to be used in parallel in
different stages of data load processing. Allocating processing threads
across processors on multiple CPUs provides the performance
advantages of true parallel operation.

Limits on query duration and time
When users create and execute a report or spreadsheet add-in query,
they may unintentionally create a very large query. Some large queries
may require too much time to execute or may access too many blocks
to run efficiently.

To help administrators, DB2 OLAP Server now provides these new
features:
v Administrators can limit the amount of time a query can run before

completion.
v Administrators can limit the number of blocks that a query can

access.
v Administrators can set these new limits at the server, application, or

database level.

This new ability is available using new essbase.cfgfile settings.

New control of agent-server threads and user logins
Two new configuration settings provide more control over agent
activity:
v AGTSVRCONNECTIONS specifies the number of server threads

that the OLAP Server creates during startup to connect to the agent.
This subset of server threads, along with the agent threads
controlled by AGENTTHREADS, are needed when users connect
from an agent to the server in order to connect to an application
and database. These threads are unrelated to the threads that are
used to direct client queries, which are specified by
SERVERTHREADS or have default specification based on the
number of licenses purchased.

v MAXLOGIN specifies the maximum number of users that can
simultaneously log in to a single application at a time. This number
includes all instances of the same user on the same computer and
application. Both the server and agent use this setting. MAXLOGIN
is unrelated to threads controlled by AGENTTHREADS,
AGTSVRCONNECTIONS, or SERVERTHREADS.
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Use these settings to match resources to load patterns:
v To support a small number of users, you can lessen the amount of

memory that the OLAP server uses by decreasing the value of
MAXLOGIN.

v To support a large number of users trying to access the same
application at the same time, you can increase the value of
AGTSVRCONNECTIONS and AGENTTHREADS.

v To support many users issuing queries at the same time, you can
increase the value of SERVERTHREADS.

Log delimiters
If you need to use external reporting tools or import log data into an
OLAP database, DB2 OLAP Server now provides the ability to specify
a delimiter between fields in DB2 OLAP Server log files:
v The essbase.cfg configuration file now supports an optional setting

DELIMITEDMSG and DELIMITER. When DELIMITDMSG is set to
TRUE, DB2 OLAP Server inserts a tilde (~) between each field of a
message and writes each entry on a single line. If DELIMITER is set
to one of three symbols, that symbol is used instead of the tilde.

v Log files contain standardized fields and field ordering. For
example, an entry with a date and time stamp uses the stamp as
the first field in the message.

New calculation functions
DB2 OLAP Server provides three new calculation functions in this
release:
v Use @PRIORS and @NEXTS to skip #MISSING values, zero (0)

values, or both, or neither during a calculation. @PRIOR and
@NEXT, which do not skip, are still available.

v Use @NAME to pass a member name as a string to another
function.

v Use @ALIAS to pass a member alias as a string to another function.

See the Technical Reference in the docs directory of your DB2 OLAP
Server installation for details.

New API functions
DB2 OLAP Server Version 8.1 has two new API functions. One is a list
of native and custom-defined calculation functions, and the other is a
new function to create a filter.

External authentication
DB2 OLAP Server now supports external authentication of users
against a non-DB2 OLAP server. For this release, DB2 OLAP Server
installs a protocol that can authenticate users for an LDAP V3 server.

To enable external authentication, administrators use this procedure:
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1. Set the AUTHENTICATIONMODULE configuration setting in the
server and client configuration file essbase.cfg.

2. Restart OLAP Server.
3. Create the user in DB2 OLAP Server with a reference to the LDAP

protocol by using either Application Manager or DB2 OLAP Server
Administration Services.

For instructions about how to set the configuration parameter, see the
Technical Reference in the docs directory of your DB2 OLAP Server
installation.

Export/Import LROs
The ability to export and re-import linked reporting object (LRO)
information from a database has been added to improve backup
capabilities and calculation performance.

You can use export LRO and import LRO (MaxL) to perform these
tasks:
v Export the catalog that maps LROs to data cells, from a database to

a single file on the server
v Load a file containing the exported LRO information.

Export of databases larger than 2 GB
Some file management systems do not support ASCII files larger than
2 GB. To avoid exceeding this limit, if DB2 OLAP Server anticipates
that an export file will be larger than 2 GB, it breaks the file into two
or more export files, as needed. Use the ESSCMD commands,
EXPORT and PAREXPORT, and the MaxL statement, export to export
databases. This new feature works the same on all operating systems.

New CALCMODE configuration setting
You can now set CALCMODE to BLOCK or BOTTOMUP by using the
configuration setting CALCMODE in the server configuration file
essbase.cfg, and give it server, application, or database scope instead
of using the @CALCMODE function. For more information, see the
configuration settings in Technical Reference in the docs directory of
your DB2 OLAP Server installation.

Improved functionality
DB2 OLAP Server Version 8.1 provides these improvements to
existing functionality:
v Improved Handling of Sessions and Requests
v Multiple DB2 OLAP Server Agents on a Single Server Computer
v Case Sensitivity Improvement
v Improved Add-in Support of Excel in Browsers
v Member Set Function Support in FIX
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v New Dimensions Sparse by Default
v Custom-Defined Functions and Macros
v Attribute Association Memory Use
v Buffered I/O Default

Improved handling of sessions and requests

System administrators can log out all users of a particular application
or database, or log out instances of particular users from a selected
scope: an application, a database, or the entire OLAP server system. If
a user request is active when the administrator tries to log off the
user, the administrator can force the user off. Using force safely
terminates the request, and then logs the user off.

Additionally, administrators may terminate specific requests that have
become problematic. For example, if a user loses the connection to the
OLAP Server during a request (for example, a calculation), the
abandoned request may cause the application to stop responding to
subsequent requests.

Each user session has a unique ID number, which can be displayed
and used by the administrator to terminate the current request
associated with that session. When the administrator terminates a
request, the user session remains active. The improved handling of
sessions and requests can be found in any of these areas:
v Application Manager (Security > Connections)
v The MaxL language interface (alter system kill request and alter

system logout session)
v The DB2 OLAP Server Administration Services Console

The improved handling of sessions and requests is also available to
API programmers, who can incorporate the following request
management functions:
v EssListRequests()
v EssKillRequest()

Case sensitivity improvement
Previous releases of DB2 OLAP Server automatically changed the case
of application and database names when they were created: the first
letter was converted to uppercase, and other letters were all
lowercase. With this release, DB2 OLAP Server creates the database
name exactly as it is entered. Some backward compatibility with
previous clients is provided:
v If a client prior to Version 7.1 FixPak 8 (Application Manager for

example) is used to create a database or application name, the name
is created with the first letter in uppercase and all other letters in
lowercase.
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v If scripts specify the incorrect case for an application or database
name, DB2 OLAP Server searches for different versions of case for
that object.

Some error messages have been rewritten to provide clarity. With this
release, behavior on NT and UNIX platforms is identical.

Improved add-in support of of Excel in browsers
DB2 OLAP Server supports the ability access the Spreadsheet Add-in
features when Microsoft Excel is invoked from Internet Explorer. If
you drill down in an Excel spreadsheet accessed using Internet
Explorer, Excel refreshes the browser and displays the requested data
automatically. Users need not perform any additional steps to refresh
the browser view.

Member set function support in FIX
All functions that return a member or set of members are now
supported when they occur within FIX statements. Member and
member set functions in FIX is also supported for partition definitions
and security filters.

New dimensions sparse by default
When you add a dimension to an existing outline, DB2 OLAP Server
makes it a sparse dimension. Prior to Version 8.1, DB2 OLAP Server
made new dimensions dense by default.

Custom defined functions and macros
Several changes have been made to custom-defined functions (CDF)
and custom-defined macros (CDM):
v You no longer need to install the Java Virtual Machine (JVM) to

create or use CDMs. CDFs still require the JVM.
v DB2 OLAP Server no longer validates function records before

completing the creation process. Errors are detected only when an
application loads the CDF. Typically this occurs during server
startup and when the MaxL refresh custom definitions statement is
executed. The DB2 OLAP Server agent checks the function for a
valid name, but does no other validation. This means that there is
no longer a need to start an application in order to create a
function.

v You can now use MaxL to create and drop function records without
loading or unloading an application.

v The rules for specifying Java classes and methods are now stricter.
v MaxL and Application Manager must be Version 8.1 to create or

delete CDFs and CDMs on the Version 8.1 server. For details, see
the Database Administrators Guide chapters about CDFs and CDMs.
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Attribute association memory use
DB2 OLAP Server has improved memory management for processing
attributes requiring less memory. This improvement is most noticeable
for applications using many attributes.

Buffered I/O default

Version 8.1 includes buffered I/O as the default. If you want to use
direct I/O, as was the default for Release 6.0 and 6.1, you can use the
configuration setting DIRECTIO TRUE.

Because buffered I/O may affect some DB2 OLAP Server caches, you
may need to adjust cache size as well as change the DIRECTIO
configuration setting.

DB2 OLAP Server 8.1 clients not available for Windows 95
Clients such as Application Manager and the Spreadsheet Add-in for
Version 8.1 are not available for Windows 95.

Introducing DB2 OLAP Integration Server for iSeries

DB2 OLAP Server for iSeries now includes the DB2 OLAP Integration Server,
a new feature on iSeries.

This section provides highlights of OLAP Integration Server that are specific
to Release 6.5 of Essbase/400 Integration Services from ShowCase, which is
the equivalent of Essbase Integration Services 6.5 from Hyperion.

Hybrid Analysis
Relational databases can store several terabytes of data and thus they
have nearly unlimited scalability. Hybrid Analysis, a new function in
DB2 OLAP Integration Server V8.1, offers you a method of integrating
your OLAP database with a relational database and thereby take
advantage of the scalability of the relational database. With Hybrid
Analysis, you can support both multidimensional databases and
relational databases, operate with almost no limitation on outline
sizes, and provide a rapid transfer of data between OLAP databases
and relational databases.

How Hybrid Analysis Works:
v Hybrid Analysis integrates an OLAP database with a relational

database by allowing a portion of an Essbase cube to reside in the
relational database. This Essbase portion consists of the lowest level
members of the dimensions defined for Hybrid Analysis and the
associated data of these members.

v Using Essbase Integration Services Console, the data in the
relational database is mapped to hierarchies in the Essbase
database. Hybrid Analysis thus eliminates the need to load and
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store members and their data within the OLAP database itself. It is
this feature which combines the efficiency of mass data scalability
with the sophisticated data analysis and rapid reporting of DB2
OLAP Server.

Using Hybrid Analysis:
v When using Hybrid Analysis, you create combinations of

multidimensional and relational data storages. You define your
Hybrid Analysis data storage options through the Integration
Services Console at the member level in the metaoutline.

v In the appropriate metaoutline dialog boxes, you perform the tasks
necessary for using Hybrid Analysis:
– Specifying the relational data source for the metaoutline
– Defining the hierarchy for the applicable dimension
– Building the metaoutline down to the appropriate level
– Performing the member and data loads

When you save a metaoutline as Hybrid Analysis-enabled, the console
warns you if the metaoutline contains dimensions or transformations
that are likely to produce incorrect member names or data values
within the Hybrid Analysis data storage.

You query the data from the relational database in much the same
manner you query data from an OLAP database, that is, by using
reporting tools such as Outline Editor, Essbase Spreadsheet Add-in,
Report Writer, and third-party tools.

You can create a Hybrid Analysis storage using the TBC sample
application.

Tables Grouped by Data Source and Owner
With multiple data source connectivity, relational tables are listed,
categorized, and ordered by the name of the source or owner and by
table type. In the left frame of the OLAP Model main window, tables
with the same data source and owner are grouped together.

Verification of Formulas
DB2 OLAP Integration Server provides a rapid method of verifying
and editing static formulas before using the formulas in DB2 OLAP
Server. Formerly, when a static formula was entered in DB2 OLAP
Integration Server, the formula was passed directly to DB2 OLAP
Server without any verification. This often caused the formula to be
rejected by DB2 OLAP Server because of simple errors such as
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misspellings or missing semicolons. Verifying the formula beforehand
can save you significant amounts of time during member and data
loads.

Formula verification takes place in the Formula tab of the Member
Properties Dialog Box in the metaoutline. During verification, the
cursor stops at the location of each error. After correcting the error,
you can either start the verification process at the beginning of the
formula or choose to find the next error in the formula.

The following highlights are specific to Release 6.2 of Essbase Integration
Services from Hyperion:

New Client Console with Dynamic Intelligent Help Window
DB2 OLAP Integration Server introduces the new Essbase Integration
Services Console and companion Intelligent Help window. The new
dockable Intelligent Help window contains dynamic links to key
program functions to automate the major operations necessary for
moving data from a relational database to online analytical processing
(OLAP). This convenient new feature provides the following enhanced
installation and client component functionality:
v Automatically detects the OLAP model fact table, dimensions, and

hierarchies to create an OLAP model.
v Automatically detects dimensions and hierarchies in an OLAP

model to create a basic metaoutline.

OLAP Metadata Catalog and Sample Application Creation
When you first start DB2 OLAP Integration Server Console after
installing DB2 OLAP Integration Server, the system displays a new
OLAP Metadata Catalog Setup dialog box. For first-time installations,
you can click a button in this dialog box to create the OLAP Metadata
Catalog.

Automatic Detection of Fact Table and Dimensions
After you click the OLAP Model icon for first-time model creation and
log in to the appropriate data source, you can choose to have the
OLAP model fact table and all related dimensions created
automatically.

A quick-access link to the automatic detection option for creating a
fact table is provided in the inline text of the Intelligent Help window
(see Intelligent Help on page 19). In addition, a Tools menu option
(Tools > Create Fact Table) is available from the OLAP Model main
window.

When you select the fact table automatic-detection option using either
method, the system displays a Create Fact Table dialog box. This
dialog box shows the fact tables detected in the current data source to
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which you are connected, along with any existing fact tables in the
OLAP Metadata Catalog that are present in the current data source.
You can select either from a list of fact tables in existing OLAP models
or from a list of potential fact table candidates to define the fact table
to use. Check boxes in the Create Fact Table dialog box enable you to
create the Time and Accounts dimensions automatically. If you prefer,
you can create the Time or Accounts dimensions manually at a later
time.

For automatic detection of dimensions, you can choose the
automatic-detection link in the Intelligent Help window or select Tools
> Create Dimensions to initiate the dimension-creation process. The
system begins by looking for all tables joined to the fact table with
primary-foreign key relationships. Next, it searches for all tables
joined to the previously detected tables and adds them to the OLAP
model schema. In a database where no primary-foreign key
relationships are defined, the system begins by searching for all tables
joined to the fact table and then uses the column name and type to
determine join keys. If two tables have the same column name and
type, the system assumes that the two tables are joined on that
column. To reduce the possibility of creating invalid dimensions, the
system does not search for join keys in any tables that are not joined
to the fact table.

Automatic Detection of Hierarchies
Like the Create Fact Table and Create Dimensions options, a new
option for automatic detection of hierarchies is provided with Version
8.1. Use the automatic-detection link to this option provided in the
text of the Intelligent Help window (see Intelligent Help on page 19).
Menu commands on the Tools menu in the OLAP Model and OLAP
Metaoutline main windows also provide access to this option. From
the OLAP Model main window, select Tools > Create Hierarchies;
from the OLAP Metaoutline main window, select Tools > Get Existing
Hierarchies. You can choose to create a single hierarchy or multiple
hierarchies.

When you select the automatic hierarchy detection option, using
either method, DB2 OLAP Integration Server searches for and detects
hierarchies that exist in the OLAP Metadata Catalog. The system then
displays the detected hierarchies in a hierarchical tree format that
includes the dimension name, the hierarchy names, and the associated
member names.

Automatic hierarchy detection does not detect any filters contained
within the hierarchies. In addition, the system compares the
hierarchical structure of the data source with that of the OLAP model
dimensions and deletes any invalid columns from the detected
hierarchies. For example, if the OLAP model Product dimension
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contains Category, Family, and SKU columns, but the data source does
not contain a Category column, the hierarchy that is returned contains
only Family and SKU columns.

Intelligent Help
This feature enhances user convenience and ease of operation. When
you open the OLAP Model or OLAP Metaoutline main window to
create or modify an OLAP model or a metaoutline, DB2 OLAP
Integration Server Console provides a new option known as
Intelligent Help to guide you through the process. Intelligent Help is
displayed in a separate window that provides numbered procedures,
along with links to new automatic detection options and frequently
used functions.

Process buttons along the top of the window contain labels for each
main group of related tasks. For example, the process buttons for the
OLAP Model tasks groups contain the following labels:
v Fact
v Dimension
v Table and Column properties
v Hierarchy
v Finish

The operations that you need to perform to create an OLAP model fall
into these main groupings.

Below the task-group process buttons, the Intelligent Help window
consists of a right and left frame:
v The left frame lists the major tasks to be performed for each of the

process groups.
v The right frame contains detailed, numbered procedures for

performing the tasks itemized in the left frame. Links to automatic
detection functions and to user interface dialog boxes are provided
in this frame, where appropriate.

The Intelligent Help window is a dockable, relocatable window that
you can move and resize as you prefer. Integration Services Console
displays the Intelligent Help window automatically the first time that
you create or open an OLAP model or metaoutline. You can click an
icon to undock the Intelligent Help window and move it away from
the console. You can click a check box to show or hide the Intelligent
Help window at startup, and you can click a Close icon to close the
window at any time during a console session.

Both the toolbar and the Tools menu in the OLAP Model and OLAP
Metaoutline main windows provide options for selecting Intelligent
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Help. The system remembers whether the Intelligent Help window
was open or closed during your last work session. If the Intelligent
Help window is open when you close an OLAP model, the window is
displayed automatically when you reopen the model to work on it at
a later time.

As always, online help is available to provide in-depth conceptual
information and dialog box entry details.

Load optimization
DB2 OLAP Version 8.1 provides five dynamic new load optimization
options for improving member and data load performance:

Member load options

v Use Distinct Clause: If the leaf node of a given dimension should
be distinct, you can choose to add the Distinct clause to the Select
statement. During a member load, only the distinct combination of
columns in the Select statement is returned, resulting in a quicker
member load. You might want to use this option, for example, if
you have created a Time dimension from the fact table.

v Use Outer Join: Use of this feature enables you to view all columns
in your DB2 OLAP Server database, whether or not the columns
between two joined tables are identical.
The result of a natural (inner) join between two tables includes
records where the joined columns match. In any row from Table A
in which a join column does not exist in Table B, that row is
dropped when data is loaded. In an outer join, however, when an
unmatched column is encountered during a data load, the
unmatched row is included in the results. The column data of the
unmatched portion is replaced with a <NULL> value.

v Allow Duplicate Shared Members: Use of this feature enables the
same member to be shared multiple times under the same parent,
resulting in faster creation of the DB2 OLAP Server outline.

Data load options

v Remove Extra Joins: This feature removes extra joins whether or
not a surrogate key is used for a data load. If a surrogate key is
used in a join, the surrogate key is loaded into DB2 OLAP Server as
an alias, and the join is eliminated in the data load.

v Use User-defined SQL: This option enables you to use an edited
version of the standard SQL generated by DB2 OLAP Integration
Server.
A new OLAP metaoutline SQL Override dialog box displays
standard data load Select statements. You can select the statements
that you want to edit. The two-frame dialog box shows the current
metaoutline in the left frame and three windows in the right frame.
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The top right-frame window lists the Current Selected SQL and is
the window in which you edit Select statements. The center
window displays the User-Defined SQL List that you create. The
bottom window displays the Standard Data Load SQL generated by
DB2 OLAP Integration Server.
When you have completed editing of standard SQL statements, you
can direct the system to use the edited version for a data load by
checking the Use User-defined SQL for Data Load option in the
OLAP Metaoutline Properties dialog box, Load Optimization tab.
For rules and guidelines related to editing the standard data load
SQL generated by DB2 OLAP Integration Server, click the Help
button in the OLAP Metaoutline SQL Override dialog box.

Sort on alternate column
This feature enables you to sort on a column that resides in the
relational data source, but which is not used in the OLAP metaoutline.
Sorting on a nondisplayed column is enabled in both recursive builds
and generation builds. The dialog boxes that you use to specify
ordering and filtering display identical column lists for selection. To
prevent multiple selections of the same column, a column that has
been selected at any generation of ordering is no longer available for
sort selection.

Loading of DB2 OLAP Server Properties from Database Columns
This new feature enables the following DB2 OLAP Server properties
to be loaded from database columns in the same way that
Consolidation Attributes and UDAs currently are loaded from DB2
OLAP Integration Server into DB2 OLAP Server:
v Two-pass calculation
v Data storage attribute
v Time balance
v Skip type
v Variance reporting
v Formulas

Inclusion of this feature follows the DB2 OLAP Server Administration
Services Console model, enabling you to define major DB2 OLAP
Server settings from within DB2 OLAP Integration Server. You define
these member settings using the metaoutline Member Properties
dialog box, Member Info tab. When property values are combined in
one database column, you can separate them with a comma or a space
(for example: +, Expense, Last, Both). When you use a word to define
a property, only the first letter is used during a member load; for
example, (O)nly or (E)xpense or (T)wo Pass Calc.
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For details on allowable values for properties loaded from database
columns, click the Help button in the Member Info tab of the
metaoutline Member Properties dialog box.

XML Import/Export
DB2 OLAP Version 8.1 XML Import/Export enables you to import
data into and export data from the OLAP Metadata Catalog. You can
now quickly transfer OLAP models and metaoutlines from one OLAP
Metadata Catalog to another through use of this feature. You can also
use an XML-based editor to rename the OLAP model associated with
a metaoutline and import the revised data into the OLAP Metadata
Catalog. Be sure to use an XML editor that supports UTF 8
UNICODE.

Extensible Markup Language (XML) consists of two parts:
v Data Type Definition (DTD): This part describes the allowable

structure of XML documents. A DTD defines the major elements
within a document, the child elements, and related attributes. It can
constrain the pieces of data that occur in a document, the hierarchy
of the data that it includes, and the number of times each piece of
data occurs. DB2 OLAP Integration Server provides a predefined
DTD to ensure that you use the same data format when you create
XML documents.

v XML documents: This part specifies how to use the tagged markup
to indicate the meaning of data, somewhat like a card catalog. In
DB2 OLAP Integration Server, the data in an XML document
describes the dimensions, members, hierarchies, and settings in
OLAP models and metaoutlines. This information is stored in tables
in the OLAP Metadata Catalog.

On the iSeries, you can use the following XML files from the OLAP
Server library/Samples/TBCModel on the IFS directory:
v sample_metaoutline.xml
v sample_model.xml
v sample_ha_metaoutline.xml
v sample_ha_model.xml

To use the new XML Import/Export feature, DB2 OLAP Integration
Server provides a new dialog box named the XML Import/Export
dialog box. Select the File > XML Import/Export command from the
OLAP Model or OLAP Metaoutline main window to access the dialog
box.

You can then select the Import tab and enter the necessary
information to open either an OLAP model or metaoutline from an
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XML file. You can also select the Export tab to save an OLAP model
or metaoutline as an XML file. Click the Save As XML File button,
enter an XML file name, and navigate to the directory where you
want to save the file.

Incremental Update to Data
This feature enables you to add to and subtract from DB2 OLAP
Server data during member loads and data loads. By default, DB2
OLAP Integration Server updates all dimensions and members.
Incremental updating of an existing DB2 OLAP Server outline is faster
than updating all dimensions and members. The Essbase Integration
Services Console includes an Incremental Update dialog box to use for
selecting update options.

For member load, you have the following options:
v Preserve all data (this is the default setting). This preserves all

existing data that applies to the changed outline when restructuring
occurs.

v Preserve input data. This preserves only those blocks containing
data that is loaded.

v Preserve level 0 data. This preserves data only for level zero
members.

v Discard all data. This clears all data from the database.

For data load, you have the following options:
v Overwrite (this is the default setting): This replaces the values in

the database with the values in the data source.
v Add: This adds values in the data source to the existing values in

the database.
v Subtract: This subtracts the values in the data source from the

existing values in the database.

For both member and data loads, you have the following Attribute
Dimension Restriction options:
v Delete all dimensions (this is the default setting): This deletes all

attribute dimensions associated with any base dimension selected
for the incremental update.

v No update to existing dimensions: This keeps attribute dimensions
unchanged while updating other areas.

v Update existing dimensions: This updates all changes to attributes.

Member Load and Data Load Filter Options
This feature enables you to limit filters to a member load or a data
load, or to apply filters to both member and data loads.
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The Essbase Integration Services Console includes a revised DB2
OLAP Server Application and Database dialog box with a simple
drop-down list from which to select or deselect filters.

Improved SQL Drill-Through
This feature takes advantage of the new data load optimizations by
including join key optimization in the SQL for drill-through. In join
key optimization, the join between a fact table and a dimension table
is removed if the join column is the same as the column selected. This
results in faster drill-through queries.

Windows Service Utility Support
This new utility adds the Windows NT and Windows 2000 service for
DB2 OLAP Integration Server, accepting parameters supported by the
olapisvr command. These parameters enable you to:
v View a list of available switches for starting DB2 OLAP Integration

Server.
v Set the buffer size that DB2 OLAP Integration Server uses when

transferring rows from the data source to the DB2 OLAP Server
database.

v Set the number of records that DB2 OLAP Integration Server
commits to DB2 OLAP Server during a data load.

v Give the log file a different name.
v Set the level of detail in the messages logged by DB2 OLAP

Integration Server.
v Set the DB2 OLAP Server message database file to a different name.
v Specify the number of threads for executing SQL, retrieving data,

transforming data, and performing a data load.
v Set the TCP port number at which DB2 OLAP Integration Server

connects with a client.
v Set the number of network listeners that DB2 OLAP Integration

Server starts.

Improved Access to the Server Log File
To assist users in analyzing and debugging member and data loads,
DB2 OLAP Integration Server now provides two methods of accessing
the Server log file:
v During a member or data load, or at any other time, you can select

Tools > View Log File to view the Server log file.
v At the completion of a member or data load, a View Log File

option button is enabled that you can select to view the Server log
file.

In both cases, DB2 OLAP Integration Server retrieves the log data and
displays it in the Server Log File window with a date and time stamp
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for each activity that has occurred during the load. For very large
member or data loads, the server retrieves only the last 1 MB of the
log file. You can copy the log file and paste it to any text editor, such
as Notepad, to print it out for review and analysis.

New Sample Application
DB2 OLAP Integration Server provides a new sample application
based on a fictitious company named The Beverage Company (TBC).
The TBC sample application demonstrates creating a Measures
dimension recursively, using a sort on an alternate column in the
relational data source, and loading metadata from database columns.
Additionally, the sample application includes UDAs and Date Time
Series data, additional years, new drill-through paths, and a new Time
table to demonstrate data load incremental updates.

The TBC sample application includes the following components:
v Sample OLAP Metadata Catalog (TBC_MD)
v Sample data source (TBC)
v Sample OLAP model (TBC Model) and sample OLAP metaoutline

(TBC Metaoutline)

For the first time, the sample application OLAP model and OLAP
metaoutline are provided in Java-supported XML format.

The Essbase Integration Services Console provides a new Sample
Application Setup dialog box that is displayed automatically after
installation of DB2 OLAP Integration Server. With the completion of a
few simple entries in the dialog box, you can now load the sample
application automatically.

This automated feature enables you to create a functional sample
application that is ready to use within minutes. You must set up the
database for the OLAP Metadata Catalog and the TBC data source,
and define open database connectivity (ODBC) connections
beforehand. When setting up ODBC connections, the user name that
you use when defining the Data Source Name (DSN) for the data
source must be TBC (tbc for Informix) because the sample tables were
created using this name.
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Terminology: IBM, ShowCase, and Hyperion

This section lists the different names that IBM, ShowCase, and Hyperion use
for the similar or equivalent products and books.

Table 2. How product names differ across IBM, ShowCase, and Hyperion

IBM ShowCase Hyperion

DB2 OLAP Server for
iSeries

Essbase/400 Hyperion Essbase OLAP
Server

DB2 OLAP Integration
Server for iSeries (OIS)

Essbase/400 Integration
Services (EIS) (This book
uses refers to EIS.)

Hyperion Integration
Services (EIS)

DB2 OLAP Server
Builder for iSeries

STRATEGY N/A

Table 3. How book titles differ across IBM, ShowCase, and Hyperion

IBM ShowCase Hyperion

Installation Guide for
iSeries

Essbase/400 Installation Guide v Essbase Installation Guide

v Essbase Integration Services
Installation Guide

Administrator’s Guide for
OLAP on iSeries

Essbase/400 Administrator’s
Guide

N/A

Administrator’s Guide for
Builder on iSeries

ShowCase STRATEGY
Administrator’s Guide)

N/A

Upgrade Guide for iSeries Upgrade Guide N/A

For a complete list of books, see “About this book” on page v.
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Chapter 2. Before you install

This chapter describes the overall installation process and steps to take before
installing DB2 OLAP Server for iSeries, Version 8.1

Read the installation checklist

This checklist summarizes the major steps of installing DB2 OLAP Server for
iSeries and DB2 OLAP Integration Server for iSeries:
v Verify that you have the hardware and software required by DB2 OLAP

Server and DB2 OLAP Integration Server. See Chapter 3, “Hardware and
software Requirements” on page 29.

v Determine what features and options you want to install:
– IBM DB2 OLAP Server Miner is a no-cost add-on feature of DB2 OLAP

Server that automatically mines through large volumes of OLAP data
and identifies and reports on specific elements that represent the most
outstanding, and unexpected, pieces of information. You can expose
problems and opportunities that were previously hidden and act on
them quickly. For information about installing OLAP Miner, see
“Installing DB2 OLAP Server Miner on Windows” on page 59.

– You can place the installation files for the OLAP client components on a
network so that your users can install the OLAP clients on Windows
without having a CD-ROM. This option is not available for Builder
clients. For more information, see “Setting up client installation from a
network file server” on page 60

– If you choose the Typical or Compact options during installation, DB2
OLAP Server installs only a subset of the documentation. To install all
the documentation, choose Custom and select the books that you want.

v If you have an earlier version of DB2 OLAP Server for iSeries on your
computer, make sure it is at least Version 7.1 or later. If your installation is
earlier, you must upgrade to Version 7.1 before installing Version 8.1.

v If you have an earlier version of DB2 OLAP Server for iSeries on your
computer, prepare for migration:
– Read the Release Notes for DB2 OLAP Server for iSeries. The Release Notes

is available from the information map on Windows: Start > Programs >
IBM DB2 OLAP Server iSeries 8.1 > Documentation. It includes
information and instructions that you need to complete your installation.

– Read the Upgrade Guide for iSeries before you install the product. This
book is available only online from:
www.ibm.com/software/data/db2/db2olap/library.html

© Copyright IBM Corp. 1998, 2002 23



It includes migration and coexistence instructions for DB2 OLAP Server
for iSeries.

– Always back up your Essbase/400 library before installation. Although
the servers will install over existing server libraries of version 7.1 or
higher, we recommend backing up your library to guard against
installation failure. For instructions, see the Administrator’s Guide for
OLAP on iSeries.

– Migrate your Relational Storage Manager (RSM) applications to the
Multidimensional Storage Manager (MSM) before installing Version 8.1.
CAUTION:
The RSM is withdrawn from Version 8.1. If you are upgrading from
DB2 OLAP Server for iSeries Version 7.1 or earlier, and you have you
have applications that use the RSM, you must first migrate them to the
MSM in Version 7.1 or you will lose data. See “Migrate from RSM to
MSM before upgrading to Version 8.1” on page 25 for more
information.

– If you installed the OLAP Miner at the Version 7.1 level, back up the
OLAP Miner configuration files for both the server and clients. The
OLAP Miner server configuration file is omserver.cfg and the file for the
clients is omclient.cfg.

v Version 7.1 editions of OLAP Miner and Information Catalog Manager
(ICM) are not uninstalled automatically. If you have the version 7.1 edition
of OLAP Miner installed on your system, or the copy of ICM that was
shipped with version 7.1 of DB2 OLAP Server, and you don’t want either of
these products in your version 8.1 environment, delete them before
installing version 8.1. The Version 8.1 installation program does not
uninstall these products, even though it removes the shortcuts from the
Start menu.

v Install the server components on your iSeries computer. You must install
the OLAP (Essbase/400) servers into a library separate from your
Warehouse Manager server. See Chapter 4, “Installing Essbase/400 OLAP
server components” on page 37 and Chapter 5, “Installing Builder server
components” on page 45.
If you plan to install into an existing Essbase/400 library, verify that no
users are connected, and stop the server in that library. For instructions on
stopping the servers, see the Administrator’s Guide for OLAP on iSeries.

v Install the client components on your Windows computer. See Chapter 6,
“Installing clients on Windows” on page 57.
If you want to make the OLAP Windows clients available on a LAN so
your users can download and install them without a CD-ROM, see “Setting
up client installation from a network file server” on page 60. You cannot
install the Warehouse Manager and Warehouse Builder clients this way.
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v If you want to install DB2 OLAP Server Miner, see “Installing DB2 OLAP
Server Miner on Windows” on page 59.

v If you installed DB2 OLAP Integration Server, create metadata catalogs. See
“OLAP metadata catalog setup” on page 66.

v Set up the sample applications. See Chapter 10, “Installing Essbase/400
sample applications” on page 79.

v Migrate your applications to Version 8.1, if any. See “Migrate from RSM to
MSM before upgrading to Version 8.1” and the Upgrade Guide for iSeries,
which is available from our Web site.

Migrate from RSM to MSM before upgrading to Version 8.1

CAUTION:
Starting in Version 8.1, the Relational Storage Manager (RSM) is withdrawn
from DB2 OLAP Server. Applications created using the RSM in previous
versions must be migrated to the Multidimensional Storage Manager
(MSM) before installing Version 8.1, or you will lose data.

If you are upgrading from an earlier version of DB2 OLAP Server and you
have applications that use the Relational Storage Manager (RSM), you must
first migrate them to the Multidimensional Storage Manager (MSM) in the
earlier version of DB2 OLAP Server before installing Version 8.1, or you will
lose data. After migrating your RSM applications to the MSM, you can install
Version 8.1, and then migrate your applications to Version 8.1.

The following steps show you how to migrate data from the RSM to the
MSM:
1. Start the DB2 OLAP Server.
2. Create an OLAP database in the appropriate application using the

Application Manager or a command from the command prompt.
3. Using the Application Manager, click Start > Open to open the outline for

the database you want to migrate.
4. Determine which dense dimension you want to be the anchor dimension,

and remove the RELANCHOR user-defined attribute to that dimension.
You must specify an anchor dimension.

5. Click File > Save As to save the outline for the new database that you
created. If you are prompted to replace or overwrite an existing file, select
Yes.
The OLAP database is activated and restructured, and the modified
outline becomes the outline for the new database. During this process, the
cube is stored in a multidimensional database.
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6. Use the Application Manager to copy any rules files, calculation scripts, or
report scripts from the original database to the migrated one. The rules
and scripts are not affected by the differences in the two storage managers.
The files exist in the same locations in the file system for both products.

7. Change any settings of the new OLAP database to match the original
database.

8. Load data into the newly migrated database, and recalculate it in the same
manner as the original. As data is loaded and calculated, it is stored in the
multidimensional database.

Check compatibility with earlier versions

It is recommended that you install the Version 8.1 OLAP server component
with Version 8.1 client products. There are limitations when you mix different
versions of clients and servers in the same environment:

Newer clients with older servers
Using a client that is newer than the server is not recommended or
supported.

Older clients with newer servers
Using a client that is older than the server version is not supported.
However, some clients of previous releases might work with the
Version 8.1 server, although with feature limitations.

Be careful when modifying Version 8.1 databases or outlines with
earlier releases of Application Manager. If you save a Version 8.1
database that contains new Version 8.1 features with an earlier release
of the Application Manager, the new features may be stripped from
the database.

Depending on the service level of an older client, it might not be able
to connect with a newer server. Additionally, the newer server might
issue messages that are incorrect in the context of the older client.

One client with many servers
If you need to connect a client to several OLAP servers on different
machines or operating systems, it is recommended that you make
them all the same version and service level. Your client should at least
be at the same as the lowest level server. If you experience problems,
you might need to use different client machines to match up with the
appropriate host, or upgrade all clients and servers to the same
service level.

Different versions of clients on the same client system
If you install more than one client component on the same computer,
such as Spreadsheet Add-in and Application Manager, make sure that
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all of the components are on the same release level. Version 8.1 clients
share.dll files that may not work with earlier client components.

IBM components with ShowCase components
Under certain circumstances, IBM supports mixing OLAP and Builder
components from IBM with OLAP and Builder components from
Showcase. See the Upgrade Guide for iSeries for more information.
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Chapter 3. Hardware and software Requirements

This chapter describes the hardware and software that you need to run DB2
OLAP Server for iSeries.

Use this chapter to verify that DB2 OLAP Server for iSeries Version 8.1
supports the platforms where you plan to install client and server software.
This chapter contains:
v iSeries hardware and software requirements
v Windows hardware and software requirements
v API toolkit hardware and software requirements

DB2 OLAP Integration Server for iSeries Version 8.1 requires, as a minimum,
FixPak 8 of DB2 OLAP Server for iSeries Version 7.1. If you want Hybrid
Analysis, you need to install DB2 OLAP Server for iSeries Version 8.1.

iSeries hardware and software requirements

OLAP server requirements
This section lists the hardware and software requirements for the OLAP server
components of DB2 OLAP Server for iSeries and DB2 OLAP Integration
Server for iSeries:

OS/400 requirements
v OS/400 Version 5, Release 1 (V5R1) or later.
v TCP/IP configured and started on the iSeries
v Java Developer Kit:

– For OS/400 V5R1: 5722JV1 Java Developer Kit 1.2 and 1.3
– For OS/400 V5R2: 5722JV1 Java Developer Kit 1.2 and 1.3

v The system value QALWOBJRST must be set to *ALL or *ALWPGMADP.
v If you are upgrading, you must install over version DB2 OLAP Server for

iSeries 7.1 (Essbase/400 4.1, 4.5, or 6.2), see the Upgrade Guide for iSeries for
more information.

v If you have more than one Essbase/400 OLAP server installed on a single
iSeries, each server must have its own IP address.
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Disk space
Make sure you have enough free disk space to install the servers.

Table 4. Disk space required for server installation

Component Space Required

Essbase/400 Servers 500 MB

Temporary Space 280 MB (After installation, this space is freed when the
installer signs off.)

Backing up existing libraries
You must install the Essbase/400 servers into a library separate from your
Warehouse Manager Server. If you plan to install into an existing Essbase/400
library, verify that no users are connected, and stop the server in that library.
For instructions on stopping the servers, see the Administrator’s Guide for
OLAP on iSeries.

Always back up your Essbase/400 library before installation. Although the
servers will install over existing server libraries of version 7.1 or higher, we
recommend backing up your library to guard against installation failure. For
instructions, see the Administrator’s Guide for OLAP on iSeries.

Configuring and starting TCP/IP
You must configure and start iSeries TCP/IP before installing the servers.
Someone trained in TCP/IP network administration should ensure proper
configuration, use, and maintenance of TCP/IP. For more information on
configuring TCP/IP, see the Administrator’s Guide for Builder on iSeries. Also see
your IBM documentation.

Essbase/400 planning tips
v Install Essbase/400 servers into an existing Essbase/400 library of version

4.1 or later (DB2 OLAP Server for iSeries 7.1 or later) or into a new library.
Do not install it into an earlier library, an existing user library, or a
Warehouse Manager Server library.

v If you are reinstalling an existing Essbase/400 library that is in use, stop the
server before installation. For instructions, see the Administrator’s Guide for
OLAP on iSeries.

v The Essbase/400 installation checks the QALWUSRDMN system value. The
default setting for the QALWUSRDMN system value is *ALL. If that setting is
unacceptable for your environment, before you install Essbase/400 servers,
specify the following libraries for QALWUSRDMN: QSYS, QRPLOBJ, QTEMP, the
Warehouse Manager Server library (default SCSERVER), and the Essbase/400
Server library (default ESSBASE). These libraries help the servers install
correctly and help prevent unpredictable results when you run client
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applications. To work with system values, use the WRKSYSVAL command and
choose option 2 to change QALWUSRDMN.

v On double-byte systems, if you are using *HEX CCSID value 65535, the
language identifier for the job may cause a default CCSID value of 5026 that
does not support lowercase English characters. If you must run the job
under the *HEX CCSID, change the language ID of the job so OS/400 does
not calculate 5026 as the default CCSID. For example, configure the job to
use ENP as the language ID. OS/400 will calculate a default CCSID value of
37, which is supported by Essbase/400. For more information, see
“Installing and running on a double byte system” on page 52.

v Essbase/400 data load and dimension build operations are most efficient
with SQL interface support. The SQL interface support is shipped as part of
the base Essbase/400 package; you do not need to install a separate SQL
interface module.

Setting up your iSeries to allow SQL loads
At an iSeries command line, type WRKRDBDIRE and press Enter. If you do not
see an entry for *LOCAL, use option 1 to add a *LOCAL entry.

Builder server requirements
This section lists the hardware and software requirements for the Warehouse
Manager and Warehouse Builder server components of DB2 OLAP Server for
iSeries and DB2 OLAP Integration Server for iSeries:

OS/400 requirements
The server installation requires and verifies the following requirements:
v OS/400 Version 4, Release 5 (V4R5) or later
v Java Developer Kit (option during OS/400 installation):

– For OS/400 V4R5: 5769JV1 Java Developer Kit 1.3
– For OS/400 V5R1: 5722JV1 Java Developer Kit 1.3

v Toolbox for Java installed:
– For OS/400 V4R5: 5769JC1 Toolbox for Java
– For OS/400 V5R1: 5722JC1 Toolbox for Java

v QShell Interpreter:
– For OS/400 V4R5: 5769SS1 OS/400 QShell Interpreter
– For OS/400 V5R1: 5722SS1 OS/400 QShell Interpreter

S36 files are no longer supported. You must use DB2/400 externally described
files.
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Disk space
Make sure that you have enough free disk space to install the servers.

Table 5. Disk space required for Builder servers

Component Space Required

Warehouse Manager Server 280MB

Temporary Space 280MB (After installation, this space is freed
when the installer signs off.)

Backing up existing libraries
You must install the Warehouse Manager and Essbase/400 servers in separate
installation libraries. If you plan to install in an existing Warehouse Manager
Server library, first end the server in that library and verify that no users are
connected. For instructions on stopping the servers, see the Administrator’s
Guide for Builder on iSeries.

Always back up your Warehouse Manager and Essbase/400 libraries before
installation. Although the servers will install over existing server libraries, we
recommend backing up your libraries to guard against installation failure. See
the Administrator’s Guide for Builder on iSeries.

Configuring and starting TCP/IP
You must configure and start iSeries TCP/IP before installing the servers.
Someone trained in TCP/IP network administration should ensure proper
setup, use, and maintenance of TCP/IP.

For more information on configuring TCP/IP, see the Administrator’s Guide for
Builder on iSeries.

Installation planning tips
v Install Warehouse Manager Server in an existing Warehouse Manager

Server library of version 3.0 or later (DB2 OLAP Server for iSeries Builder
1.1), or in a new library. Do not install it in an existing user library or an
Essbase/400 library.

v Configure and start iSeries (AS/400) TCP/IP before you enable STRATEGY
TCP/IP. You do not have to enable STRATEGY TCP/IP support at
installation time. You can enable it later using the CHGSCSVRA command.

v Remember the IP address of your iSeries and the port number assigned to
each library. You and your users will need this information to complete
ODBC setup.

During Warehouse Manager Server installation, you will be prompted to add
the Warehouse Manager library to QALWUSRDMN. The default setting for the
QALWUSRDMN system value is *ALL. If that setting is not acceptable for your
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environment, before you install Warehouse Manager Server, specify the
following libraries for QALWUSRDMN: QSYS, QRPLOBJ, QTEMP, and the Warehouse
Manager Server library (default SCSERVER).

These libraries help Warehouse Manager Server install correctly and help
prevent unpredictable results when you run client applications. To work with
system values, use the iSeries (AS/400) command WRKSYSVAL and choose
option 2 to change QALWUSRDMN.

Additional considerations
v Warehouse Manager Server sets *PUBLIC Exclude as the default authority to

Warehouse Manager Client and Warehouse Builder. A profile with *ALLOBJ
authority can use Warehouse Manager Client to authorize other users to
access Warehouse Manager Client or Warehouse Builder.

v The user profile QUSER should have the Maximum Allowed Storage (MAXSTG)
parameter set to the default *NOMAX. Otherwise, you may have difficulty
connecting through TCP/IP and running large queries in batch.

v ShowCase security applied to a supplemental group (via Warehouse
Manager Client) is not supported. However, AS/400 security applied to a
supplemental group (via a non-ShowCase interface) is supported. iSeries
authorities applied to a user profile as a result of supplemental groups will
be honored when the user is running applications connected to Warehouse
Manager Server. Thus, STRATEGY supports iSeries security against
supplemental groups, but it does not recognize STRATEGY security applied
to a supplemental group.

J.D. Edwards requirements
Although DB2 OLAP Server for iSeries does not support versions A7.x and
A8.x of J.D. Edwards WorldSoftware and version B7.33.x of J.D. Edwards
OneWorld Software, STRATEGY 6.5 products do. This section is provided for
reference only.

STRATEGY provides user profile, data dictionary, and cost center security
support for these WorldSoftware versions. Due to internal changes to the
WorldSoftware database structure, user-developed queries or other
STRATEGY applications may not be interchangeable across WorldSoftware
release boundaries. See your J.D. Edwards documentation for changes to
WorldSoftware database structures.

Administrators can now use the SETJDEOWA command to enable STRATEGY to
recognize environment information for OneWorld users who do not have an
iSeries user profile. For instructions, see the Administrator’s Guide for Builder on
iSeries.
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Windows hardware and software requirements

The system requirements of the Windows components are described in
Table 6. API client requirements are described in “API toolkit hardware and
software requirements” on page 35.

For all types of client installations, you must have administrator authority to
your PC registry to install the clients. For more information, see your
Windows documentation.

Table 6. Summary of Windows requirements

Component Requirement

Microsoft Windows for
the OLAP clients

v Windows XP

v Windows ME – OLAP clients only, not Builder

v Windows 2000

v Windows NT 4.0; Service Pack 5 is required by DB2
OLAP Integration Server

v Windows 98

Windows NT 3.5.1 is not supported

Microsoft Windows for
the Builder clients

v Windows XP

v Windows 2000

v Windows NT 4.0, Service Pack 5

v Windows 98

Microsoft Windows for
the OLAP Miner server

v Windows XP

v Windows 2000

v Windows NT 4.0

Microsoft Windows for
the OLAP Miner client

v Windows XP

v Windows 2000

v Windows NT 4.0, Service Pack 5

v Windows 98

Microsoft Windows for
the Enterprise Server

Windows NT 4.0, Windows 2000, or Windows XP

Microsoft Excel version Excel 2000, Excel XP

Lotus 1-2-3 version Lotus 1-2-3 97, plus 9.7, 9.6 and 9.5

Microprocessor Pentium or better or equivalent

Display Resolution of at least 640 x 480 (800 x 600 or more
recommended)

RAM 64MB of RAM or the minimum required by your operating
system.
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Table 6. Summary of Windows requirements (continued)

Component Requirement

Disk space Hard Disk Space 240MB or greater available hard disk
space for the following applications (space needed will
vary depending on components selected):

v Warehouse Manager Client

v Warehouse Builder

v Essbase Application Manager

v Essbase Spreadsheet Add-in for Lotus Millennium or
later

v Essbase Spreadsheet Add-in for Excel 97 and Excel 2000

v Enterprise Server (requires Windows NT, Windows 2000,
or Windows XP)

v Sample files

Network protocol TCP/IP

API toolkit hardware and software requirements

The system requirements of the API toolkit development platforms on
Windows platforms are described in Table 7.

Table 7. API toolkit development platforms

Platform Supported versions

Windows version v Windows XP on Pentium or better, or equivalent
computers

v Windows ME on Pentium or better, or equivalent
computers

v Windows NT 4.0 on Pentium or better, or equivalent
computers

v Windows 2000 on Pentium or better, or equivalent
computers

RAM v 64 MB RAM (128 or more MB recommended) for
Windows 2000, Windows NT, or Windows 98

Swap space: At least two times the amount of physical
memory is recommended when physical memory is
less than .5 GB. Contact your system administrator or
hardware vendor for optimum swap configuration.

Disk Space v 15 MB for 32-bit DB2 OLAP Server API on Windows
XP, Windows 2000, Windows NT, on Pentium
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Chapter 4. Installing Essbase/400 OLAP server
components

This chapter describes how to install the Essbase/400 OLAP server
components of DB2 OLAP Server for iSeries. For information about installing
the Warehouse Manager and Warehouse Builder server components, see
Chapter 5, “Installing Builder server components” on page 45.

Before you install

Before you begin, make sure your installation has all required software. If you
are installing on a system with Double-Byte Character Set (DBCS) support, see
“Installing and running on a double-byte system” on page 42.

During installation, the following server components will be installed by
default:
v Essbase/400 OLAP Server

v Essbase/400 Integration Services (EIS). EIS uses port 3388 by default.

Beginning server installation

1. Load the DB2 OLAP Server for iSeries Server CD into the iSeries CD
drive.

2. Log on with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG,
*SAVSYS, *JOBCTL, and *SECADM special authorities are needed). The
profile you use must be a permanent profile that does not belong to any
groups or supplemental groups. If it is removed from the system, you
may have to reinstall the server.

3. Type LODRUN and press F4.
4. You will be prompted for a device name. Choose *OPT or the name of your

optical device.
5. You will be prompted for a path name. Accept the default path ‘/’.
6. Follow the screen instructions and use this chapter to complete the

installation.
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Installation options

Each heading in the following sections matches a screen in the server
installation. The installation displays recommended values for the options. If
you are upgrading Essbase/400 server software, existing values are retrieved.

Warehouse Manager Server

v This server supports Warehouse Builder and Warehouse Manager
Client.

v You cannot install Warehouse Manager Server and Essbase/400
Server into the same server library.

Essbase/400 Server

v This server supports Essbase/400 Application Manager, Microsoft
Excel and Lotus 1-2-3 Essbase/400 add-ins, and other
Essbase/400-compliant PC software.

v For information about requirements for Essbase/400 OLAP servers,
see Chapter 4, “Installing Essbase/400 OLAP server components”
on page 37.

Essbase/400 Integration Services (EIS)

The server component of DB2 OLAP Integration Server (Essbase/400
Integration Services, or EIS) will be installed into the same library as
the Essbase/400 OLAP server. EIS uses port 3388 by default.

National Language Support
1. Specify the primary and secondary languages for the product. Choose ENU

for English lowercase or ENP for English uppercase. Essbase/400
commands use the primary language.

Essbase/400 installation options

This section describes the Essbase/400 server components installation. The
recommended values are displayed. Change options as required.

Essbase/400 server installation library
1. Specify the library in which to install Essbase/400 server components. The

screen displays current Essbase/400 libraries. Choose a library to upgrade,
or press F6 to install a new library. The library you select to upgrade
cannot be running.
The default library name is ESSBASE. In addition, the root Integrated File
System (IFS) path used for the installation is based on the specified library
name (the default is /ESSBASE).

Auxiliary Storage Pool ID. If you add a library, you are prompted to enter
the ASP ID. Accept the default or enter the number of the ASP from which
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the system should allocate storage for the Essbase/400 installation library. IFS
information installed with Essbase/400 is placed in the ASP.

Essbase/400 server
1. EBCDIC CCSID. Essbase/400 uses the EBCDIC CCSID to represent

character data when interacting with DB2/400 and OS/400. The
recommended value for your system is displayed. Essbase/400 converts all
character data to the EBCDIC CCSID when:
v Using an Essbase/400 OS/400 interface or command (these interfaces

include the Essbase/400 servers, ESSCMD command interface, MaxL
command interface, and Warehouse Builder run-time interfaces)

v Loading data using SQL and referencing iSeries physical or logical files
v Writing messages to the OS/400 job log

You can specify only one EBCDIC CCSID for each Essbase/400 OLAP
Server. This server supports single-byte and double-byte CCSIDS. If your
environment requires double-byte character support, see “Installing and
running on a double-byte system” on page 42.

If you have Warehouse Manager Server installed, the EBCDIC CCSID for
Warehouse Manager Server must be the same as the EBCDIC CCSID for
all Essbase/400 servers it uses.

2. ASCII CCSID. Essbase/400 uses the ASCII CCSID to represent character
data when interacting with Essbase/400 client software (for example:
Analyzer, Excel add-ins). The recommended ASCII CCSID value for your
system is displayed.
The installation calculates this value based on the EBCDIC CCSID value.
For example, if the EBCDIC CCSID is 37, the matching ASCII CCSID is
1252, which supports Western European languages (English, French,
German, Italian). For the recommended EBCDIC and ASCII CCSID pairs,
see Table 8 on page 40.
You can specify only one ASCII CCSID for each Essbase/400 OLAP Server.
Therefore, all PC clients that access the server must use the same ASCII
CCSID. The ASCII CCSID should be supported by Windows (ANSI code).
If you do not use an ANSI-equivalent CCSID, characters sent from the
server may appear incorrectly.
Essbase/400 converts all character data to the ASCII CCSID when:
v Communicating with a PC client (for example: Analyzer, Excel add-ins)
v Saving and loading Essbase/400 outlines (.otl), load and build rule files

(.rul), and calculation script files (.csc) to the Integrated File System (IFS)

Note: For general information about iSeries CCSIDs, see your IBM
documentation.
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3. Server Threads. Enter the maximum number of server threads that can be
created by Essbase/400 when an application is started. The default is 5.
This value should be the average number of concurrent report requests
expected for each application.

4. IP Address. Enter the IP address the server should use to listen for
incoming client requests. You must enter a value for this option. If you do
not know the value, enter *DEFER. However, before using the server, you
must specify an IP address using the CHGESSENV command. The value must
be unique for each Essbase/400 library.

Notes:

a. If you are installing over an existing library, the current IP address is
displayed.

b. To display the IP addresses configured on your iSeries, enter the
command CFGTCP and choose option 1.

c. Enter *ALL if you have only one Essbase/400 library and it listens for
incoming client TCP/IP requests using all IP interfaces configured on
the iSeries. When your iSeries is configured with multiple TCP/IP
interfaces connected to different IP sub-networks, specifying *ALL
prevents you from running multiple copies of Essbase/400 on a single
iSeries.

Changing Essbase/400 options after installation

To change the Product Serial Number:
Use the CHGESSENV command.

To change CCSID Values: See the Administrator’s Guide for OLAP on
iSeries.

To change Server Threads: Use the CHGESSENV command.

To change the IP Address: Use the CHGESSENV command. The value must
be unique for each Essbase/400 library.

CCSID pairs
The following EBCDIC and ASCII CCSID pairs are recommended for
Warehouse Manager Server and Essbase/400 OLAP Server. For details on
Essbase/400 CCSIDs, see “Essbase/400 server” on page 39.

Table 8. Recommended Essbase/400 EBCDIC & ASCII CCSID Pairs

Country, Geographic Region, or Language Group EBCDIC
CCSID

Matching
ASCII
CCSID

United States/Canada/Brazil 37, 1140 1252

Multi-national #1 256 1252

Germany/Austria 273, 1141 1252
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Table 8. Recommended Essbase/400 EBCDIC & ASCII CCSID Pairs (continued)

Country, Geographic Region, or Language Group EBCDIC
CCSID

Matching
ASCII
CCSID

Denmark/Norway 277, 1142 1252

Finland/Sweden 278, 1143 1252

Italy 280, 1144 1252

Spain/Latin America 284, 1145 1252

United Kingdom 285, 1146 1252

France 297, 1147 1252

Greece 423, 875 1253

Multi-national #5 500, 1148 1252

Korea (single-byte) 833 1040, 1088

Korea (double-byte) 933 944, 949

Chinese Simplified (single-byte) 836 1115

Chinese Simplified (double-byte) 935 1381

Chinese Traditional (double-byte) 937 938

Chinese Traditional (single-byte) 37, 28709 904

Japan (double-byte) 939, 5035 932, 943

Japan (single-byte) 1027 932

Thailand 838, 9030 874

Central Europe (Bosnia, Croatia, Czech Republic,
Hungary, etc.)

870 1250

Iceland 871, 1149 1252

Cyrillic Multinational 880, 1025 1251

Baltics 1112, 1122 1250

Hebrew 62235 1255

Arabic (Essbase only. Not yet supported in Analyzer.) 62224 1256

Starting Essbase/400
If you did not provide a serial number or IP address, you will not see the
Starting Essbase screen.
1. Enter Y to start the Essbase/400 OLAP Server if the following three

statements are true:
v You are installing Essbase/400 into a new library.
v You want to initialize the Essbase/400 security file.
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v You did not choose *DEFER for the product serial number and IP
address.

Note: The only time the Essbase/400 OLAP Server is started automatically
is if you choose Y at this prompt.

2. Enter and remember the following security information:

Company Name
Enter the name of your company. This information will be
displayed in the registration message when you start Essbase. The
name must be at least three characters long.

User ID
Enter the Essbase administrator user ID, which is needed for
security administration and ending the server. This ID is not the
OS/400 user ID. The Essbase user ID must be at least three
characters long. Write down your user ID.

Password
Enter the password for the Essbase administrator user ID. The
password must be at least six characters long and different from
the user ID. Write down your password.

Starting Essbase after installation
For information on starting the servers, see the Administrator’s Guide for OLAP
on iSeries.

Finalizing Essbase/400 server installation options
You are finished setting Essbase/400 installation options. If you deferred any
options, configure them later with the CHGESSENV command.

To start the installation, press Enter.

Installing and running on a double-byte system

This section applies to countries using a Double-Byte Character Set (DBCS) to
represent character data (for example, Japan).

Using the correct CCSID
If you are installing Essbase/400 on a system with DBCS support, use a
CCSID that supports lowercase English characters or 65535 (*HEX). If you set
the CCSID value to 65535, the iSeries chooses a default CCSID for the job
based on the job’s language identifier. However, make sure the default CCSID
supports lowercase English characters (ENU).
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For example, if the job CCSID is 65535 (*HEX) with a language identifier of
JPN, 5026 becomes the default CCSID. But for Essbase/400, 5026 does not
support standard lowercase English characters and is not supported for
Essbase/400 installation or operation.

If you must run an Essbase job under a *HEX CCSID, change the job’s
language ID so 5026 is not the default CCSID. For example, using ENP
(English uppercase) will calculate a default CCSID of 37.

Using the correct EBCDIC CCSID
The CCSID of the iSeries job running the Essbase/400 OLAP Server or
command interface must be the same as the Essbase/400 EBCDIC CCSID or
65535 (*HEX). Otherwise, you may get unpredictable results.

Any job that performs Essbase/400 operations (for example: starting the
server, ESSCMD, MaxL, Warehouse Builder) must also use the same EBCDIC
CCSID that Essbase/400 uses or 65535 (*HEX). Use 65535 only when data
stored in DB2/400 tables for dimension building or data loading have the
wrong CCSID for the data stored in them. When using 65535 for the
Essbase/400 OLAP Server job CCSID, the data contained in the DB2 files
must use the server EBCDIC CCSID. See the Administrator’s Guide for OLAP on
iSeries.

To change CCSIDs after installation, see the Administrator’s Guide for OLAP on
iSeries.

Changing CCSIDs for profiles and jobs
The CCSID can be changed once for each OS/400 user by changing the
OS/400 user profile, or by changing the current job each time a user signs on.

Changing the CCSID for a user profile
If you have *SECOFR user class, use the following command. The ccsidvalue
should be a CCSID that supports lowercase English characters or 65535
(*HEX).
CHGUSRPRF USRPRF(userid) CCSID(ccsidvalue)

After running the command, the user specified by userid must sign off the
system and back on.

Changing the CCSID for a job
Use the following command each time you sign on to the system.
CHGJOB JOB(*) CCSID(ccsidvalue)

Chapter 4. Installing Essbase/400 OLAP server components 43



44 DB2 OLAP Server Installation Guide for iSeries



Chapter 5. Installing Builder server components

This chapter describes how to install the Warehouse Manager and Warehouse
Builder server components of DB2 OLAP Server for iSeries Builder. For
information about installing the OLAP server components, see Chapter 4,
“Installing Essbase/400 OLAP server components” on page 37.

Before you install

v Read the checklist in Chapter 2, “Before you install” on page 23.
v Always save server information with the SAVSRVRINF command before you

install over previous versions of Builder in DB2 OLAP Server for iSeries 1.1
(STRATEGY 3.0 or later). See the Administrator’s Guide for Builder on iSeries
for more information.

v Read Chapter 3, “Hardware and software Requirements” on page 29 for all
prerequisites. If you are installing on a system with Double Byte Character
Set (DBCS) support, see “Installing and running on a double byte system”
on page 52.

v When you install the servers for Warehouse Manager and Warehouse
Builder, the installation selects a TCP/IP port number for you. If you want
to select your own port number, use the WRKSRVTBLE command before
installing to find an available number.

Beginning installation

1. Save your current server information with the SAVSRVRINF command. See
the Administrator’s Guide for Builder on iSeries.

2. Load the DB2 OLAP Server for iSeries Server CD into the iSeries CD
drive.

3. Log on with QSECOFR or equivalent authority (*ALLOBJ, *IOSYSCFG,
*SAVSYS, *JOBCTL, and *SECADM special authorities are needed). The
profile you use must be a permanent profile that does not belong to any
groups or supplemental groups. If it is removed from the system, you
may have to reinstall the server.

4. Type LODRUN and press F4.
5. You will be prompted for a device name. Choose *OPT or the name of your

optical device.
6. You will be prompted for a path name. Accept the default path ‘/’.
7. Follow the screen instructions and use this chapter to complete the

installation.
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Initial installation options

The options you choose in the initial installation screens determine the
screens, options, and order of your installation. Each heading in the following
sections matches a screen in the server installation.

The installation displays recommended values for the options. If you are
upgrading STRATEGY server software, existing values are retrieved.

Warehouse Manager Server

v This server supports Warehouse Builder and Warehouse Manager
Client.

v You cannot install Warehouse Manager Server and Essbase/400
Server into the same server library.

Essbase/400 Server

v This server supports Essbase/400 Application Manager, Microsoft
Excel and Lotus 1-2-3 Essbase/400 add-ins, and other
Essbase/400-compliant PC software.

v For information about requirements for Essbase/400 OLAP servers,
see Chapter 4, “Installing Essbase/400 OLAP server components”
on page 37.

Essbase/400 Integration Services (EIS)

The server component of DB2 OLAP Integration Server (Essbase/400
Integration Services, or EIS) will be installed into the same library as
the Essbase/400 OLAP server. EIS uses port 3388 by default.

Table 9 lists the STRATEGY software and the server it communicates with.
Only some of these are part of the IBM product.

Table 9. STRATEGY PC Software

PC Software Purpose Server*

Analyzer Data analysis ESS, WM

Analyzer for the Web Data analysis via an intranet or
extranet

ESS, WM

Query Relational and multidimensional
database query tool

WM, ESS

Report Writer Relational and multidimensional
database report writer

WM, ESS

Enterprise Server Enterprise Reporting WM

Warehouse Builder Data cleansing, transformation,
and distribution

WM, ESS

Warehouse Manager Client Database administration WM
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Table 9. STRATEGY PC Software (continued)

PC Software Purpose Server*

Essbase/400 Application Manager Multidimensional database
administration

ESS

Essbase/400 Excel add-ins Data analysis ESS

Essbase/400 Lotus 1-2-3
Millennium add-ins

Data analysis ESS

*WM refers to Warehouse Manager Server. ESS refers to Essbase/400 Server.

National Language Support
Specify the primary and secondary languages for the STRATEGY products.
Choose ENU for English lowercase or ENP for English uppercase. STRATEGY
commands use the primary language.

If you are installing Warehouse Manager Server, continue with the next
section. Otherwise, skip to “Essbase/400 installation options” on page 38.

Warehouse Manager server installation options

This section describes the Warehouse Manager Server installation. Each
heading matches a screen in the installation. For the Essbase/400 Server
installation, see “Essbase/400 installation options” on page 38.

Warehouse Manager server library
Specify the library in which to install Warehouse Manager Server. The screen
displays current Warehouse Manager Server libraries. Choose a library to
upgrade, or press F6 to install a new library.

The default library name is OLAPBLDSVR. In addition, the root Integrated
File System (IFS) path used for the installation is based on the specified
library name (the default is /OLAPBLDSVR).

Auxiliary Storage Pool (ASP) ID
If you add a library, you are prompted to enter the ASP ID. Accept the default
or enter the number of the ASP from which the system should allocate storage
for the Warehouse Manager Server library. (IFS information installed with
Warehouse Manager Server is always placed in the system ASP.)

To change the library after installation
To change the library, you must reinstall it. Before you install a new library,
save the catalog files from the old library using the SAVSRVRINF command and
restore into the new library using the RSTSRVRINF command. See the
Administrator’s Guide for Builder on iSeries for more information.
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Warehouse Manager TCP/IP port configuration
TCP/IP communications runs STRATEGY and Essbase/400 client applications,
and the installation requires a valid TCP/IP port number. If you are installing
over Version 7.1 (STRATEGY 4.x) and you currently have only one port,
accept the default port number (43419 or the next available number) or enter a
port number in the range of 6000-65535, using the iSeries command
WRKSRVTBLE to find available port numbers.

Note: Record your TCP/IP port number. You will need it when installing the
client software.

To change the TCP/IP port number after installation

Note: The CHGSCSVRA command will stop the server, disconnect all current
users, and stop current jobs. It will also start the server after changes
have been made.

1. Add the server library name to your library list.
2. Type WRKSRVTBLE to determine if the port you want to use is available.
3. Type CHGSCSVRA, and add the new port number, subsystem, and library.

Note: If you retain both ports from a STRATEGY 3.x or 4.x release, you can
configure the second port with the CHGSCSVRA parameter
SecondaryTCPIPPort. For more on CHGSCSVRA settings for Analyzer
functionality, see the Administrator’s Guide for Builder on iSeries

Work management and CCSID configuration
Specify the following options for Warehouse Manager Server. If you will not
use Analyzer-related applications, accept the defaults for the Analyzer OLAP
options.

Relational subsystem and library
Warehouse Manager TCP/IP jobs will run in the relational subsystem. Your
current subsystem, as determined by the QCTLSBSD system value, is
displayed and should not be changed.

Note: If the controlling subsystem is QBASE, then QBASE is the default. If
the controlling subsystem is QCTL, then QCMN is the default. To find
the controlling subsystem, type DSPSYSVAL SYSVAL(QCTLSBSD).

The subsystem description resides in the specified library. QSYS is the default.

To change CCSIDs after installation
To change the server CCSID, reinstall Warehouse Manager Server. To change
the client CCSID, see the Administrator’s Guide for Builder on iSeries.
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CCSID Pairs
The following EBCDIC and ASCII CCSID pairs are recommended for
Warehouse Manager Server and Essbase/400 Server. For details on
Essbase/400 CCSIDs, see “Essbase/400 server” on page 39.

Table 10. Recommended Warehouse Manager Server and Essbase/400 EBCDIC &
ASCII CCSID Pairs

Country, Geographic Region, or Language Group EBCDIC
CCSID

Matching
ASCII
CCSID

United States/Canada/Brazil 37, 1140 1252

Multi-national #1 256 1252

Germany/Austria 273, 1141 1252

Denmark/Norway 277, 1142 1252

Finland/Sweden 278, 1143 1252

Italy 280, 1144 1252

Spain/Latin America 284, 1145 1252

United Kingdom 285, 1146 1252

France 297, 1147 1252

Greece 423, 875 1253

Multi-national #5 500, 1148 1252

Korea (single-byte) 833 1040, 1088

Korea (double-byte) 933 944, 949

Chinese Simplified (single-byte) 836 1115

Chinese Simplified (double-byte) 935 1381

Chinese Traditional (double-byte) 937 938

Chinese Traditional (single-byte) 37, 28709 904

Japan (double-byte) 939, 5035 932, 943

Japan (single-byte) 1027 932

Thailand 838, 9030 874

Central Europe (Bosnia, Croatia, Czech Republic,
Hungary, etc.)

870 1250

Iceland 871, 1149 1252

Cyrillic Multinational 880, 1025 1251

Baltics 1112, 1122 1250

Hebrew 62235 1255

Arabic (Essbase only. Not yet supported in Analyzer.) 62224 1256
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Schedule Jar file compile
To reduce server start-up time, the .jar files installed in your Integrated File
System (IFS) must be compiled before you start the server. Because the
compile may affect system performance, you can compile immediately after
installation or enter a date and time to compile.

If you enter *IMMED, the date parameter will be ignored and the jar files will
compile immediately after installation. If you enter a time and date, the files
will compile at the time and date you specify.

Important: If you are migrating Enterprise Reporting objects, we recommend
scheduling the .jar files to compile after the migration. For best
performance, choose *DEFER now and use the CMPSCJAR command
to compile the .jar files after migration. Or schedule the compile
during off-peak hours after migration.

Compile time may vary from one to two hours depending on system
resources and will be shorter if the Warehouse Manager Server is not running.

To compile Jar files after installation
At an iSeries command line, run the CMPSCJAR command. You should also run
the command after you apply PTFs to the Java Toolbox.

Security settings
Specify whether your Warehouse Manager users will have access to all
libraries (*ALL) on the iSeries or only libraries and files in their library list
(*LIBL). This setting applies only to STRATEGY applications using Warehouse
Manager Server.

To change security settings after installation
1. Open Warehouse Manager Client.
2. From the menus, choose:

Manage
Server Options

Security

You can also use the iSeries commands SETLIBACC and CHGSRVRDFT located in
the Warehouse Manager Server library. SETLIBACC determines library access.
CHGSRVRDFT defines default server security options. To run these commands,
first add the Warehouse Manager Server library (for example, OLAPBLDSVR)
to your library list.

Storage CCSID configuration
The storage CCSID value specifies the coded character set identifier that stores
library, file, and column alias names. It also stores data views, Warehouse
Builder distribution sets and definitions, and shared query information.
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This value must be a STRATEGY-supported, single-byte EBCDIC CCSID.
Enter your five-digit CCSID value, or use *CALC or *HEX to let the
installation calculate it based on your iSeries (AS/400) system settings.
Table 11 shows the EBCDIC CCSIDs supported for the Warehouse Manager
storage CCSID value.

If you are installing on a double-byte system, use 65535 (*HEX). See
“Installing and running on a double byte system” on page 52.

Table 11. Supported Warehouse Manager Storage EBCDIC CCSIDs

Country, Geographic Region, or Language Group EBCDIC CCSID

United States/Canada/Brazil 37

Multi-national #1 256

Germany/Austria 273

Denmark/Norway 277

Finland/Sweden 278

Italy 280

Spain/Latin America 284

United Kingdom 285

France 297

Greece 423, 875

Hebrew 62235

Multi-national #5 500

Korea 833

Chinese Simplified 836

Chinese Traditional 37, 28709

Thailand 838

Central Europe (Bosnia, Croatia, Czech Republic, Hungary, etc.) 870

Iceland 871

Cyrillic Multinational 880, 1025

Japan 1027

Iran 1097

Hexadecimal (*HEX) 65535

Note: For general information about iSeries CCSIDs, including complete
language and country settings, see the AS/400 National Language Support
manual.
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To change storage CCSIDs after installation
Reinstall Warehouse Manager Server and specify a different CCSID.

Warehouse Builder configuration

Warehouse Builder subsystem and library
Warehouse Builder distribution jobs run in the Warehouse Builder
Subsystem. Your current subsystem, as determined by the QCTLSBSD
system value, is displayed and should not be changed. You should
use the same subsystem as your TCP/IP subsystem.

If the controlling subsystem is QBASE, then QBASE is the default. If
the controlling subsystem is QCTL, then QCMN is the default. To find
the controlling subsystem, type DSPSYSVAL SYSVAL(QCTLSBSD).

The current subsystem description resides in the specified Library.

Sample database

The STRATEGY sample database, SCSAMPLE45, will be installed in the
SCSAMPLE45 library. You will use this database in the STRATEGY
tutorials. For more information about the database, see the
Administrator’s Guide for Builder on iSeries.

You can install or reinstall the sample database with the RSTSMPLB
command.

Finalizing warehouse manager server installation options

At this point, you are finished setting Warehouse Manager Server
installation options. If you chose to install Essbase/400, the
installation options will follow. If not, the Warehouse Manager
installation will begin.

Installing and running on a double byte system

This section applies to countries using a Double Byte Character Set (DBCS) to
represent character data (for example, Japan).

Using the correct CCSID
If you are installing STRATEGY on a system with DBCS support, use a CCSID
that supports lowercase English characters or 65535 (*HEX). If you set the
CCSID value to 65535, the iSeries chooses a default CCSID for the job based
on the job’s language identifier. However, make sure the default CCSID
supports lowercase English characters (ENU).

For example, if the job CCSID is 65535 (*HEX) with a language identifier of
JPN, 5026 becomes the default CCSID. But for Essbase/400, 5026 does not
support standard lowercase English characters and is not supported for
Essbase/400 installation or operation.

52 DB2 OLAP Server Installation Guide for iSeries



If you must run an Essbase job under a *HEX CCSID, change the language ID
of the job so 5026 is not the default CCSID. For example, using ENP (English
uppercase) will calculate a default CCSID of 37.

Using the correct EBCDIC CCSID
The CCSID of the iSeries job running the Essbase/400 Server or command
interface must be the same as the Essbase/400 EBCDIC CCSID or 65535
(*HEX). Otherwise, you may get unpredictable results.

Any job that performs Essbase/400 operations (for example: starts the server,
ESSCMD, MaxL, Warehouse Builder) must also use the same EBCDIC CCSID
that Essbase/400 uses or 65535 (*HEX).

Use 65535 only when data stored in DB2/400 tables for dimension building or
data loading have the wrong CCSID for the data stored in them.

When using 65535 for the Essbase/400 Server job CCSID, the data contained
in the DB2 files must use the server EBCDIC CCSID. See the Administrator’s
Guide for Builder on iSeries.

To change CCSIDs after Essbase/400 is installed, see the Administrator’s Guide
for Builder on iSeries.

Changing CCSIDs for profiles and jobs
The CCSID can be changed once for each OS/400 user by changing the
OS/400 user profile, or by changing the current job each time a user signs on.

To change the CCSID for a user profile
If you have *SECOFR authority, use the following command. The ccsidvalue
should be a CCSID that supports lowercase English characters or 65535
(*HEX).
CHGUSRPRF USRPRF(userid) CCSID(ccsidvalue)

After the command is run, the user specified by userid should sign off the
system and back on.

To change the CCSID for a job
Use the following command each time you sign on to the system.
CHGJOB JOB(*) CCSID(ccsidvalue)

Setting up your PC for double byte character data
If you are using a Double Byte Character Set (DBCS) to represent character
data (for example, Japanese or Chinese), use these steps to set up your PCs.
1. Install Client Access version V4R5 or later from your iSeries. The path is:

/qibm/ProdData/CA400/Express/Install/Image
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2. Install STRATEGY using “Before you install” on page 45 and Chapter 4,
“Installing Essbase/400 OLAP server components” on page 37.

3. Configure a data source using Chapter 8, “Setting Up an ODBC data
source for Builder” on page 71.

4. To open the AS/400 Test Connection, from the Windows Start menu,
choose:
Programs

IBM DB2 OLAP Server 8.1 - iSeries
DB2 OLAP Server Builder Clients
iSeries Test Connection

5. Highlight your data source, and click Setup.
This opens the ShowCase ODBC Setup dialog box.

6. Click the Translation tab, and check the Convert OEM to ANSI
Characters box, as in Figure 1.

7. Click OK.
8. Click Global Settings.

This opens the Settings dialog box.
9. Click the Double Byte tab, and choose the correct translation for your

data, as shown in Figure 2.

Figure 1. Convert OEM to ANSI characters
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10. When you open STRATEGY for the first time, you will be prompted to
log on to the iSeries with Client Access to load EBCDIC to ASCII
translation tables. See Figure 3.

After this initial connection, the tables will exist on your PC.

Figure 2. Choosing the correct translation

Figure 3. Sign on to load translation tables
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Chapter 6. Installing clients on Windows

This chapter tells you how to install the Windows client components for DB2
OLAP Server for iSeries, DB2 OLAP Integration Server for iSeries, and DB2
OLAP Server for iSeries Builder.

Installing OLAP, EIS, and Builder clients

Make sure you consider the following important changes in how clients are
installed in version 8.1.

Do not install in a directory whose name includes blanks
If you install Version 8.1 on a Windows computer on which you have
an earlier version of DB2 OLAP Server, and if you accepted the
default installation directory name when you installed the earlier
version, then some functions in version 8.1 might fail. In earlier
versions, the default installation directory name contained blanks,
which causes the failure. Additionally, other functions might produce
unpredictable results if the name of the installation directory contains
underscores, dashes, or other special characters. If you are installing
DB2 OLAP Server version 8.1 as a first-time installation, you are
prompted for an installation directory. The new default directory for
version 8.1 has the correct naming scheme, but if you choose to store
DB2 OLAP Server in a different directory, it is strongly recommended
that your directory name does not contain blanks, underscores,
dashes, or other special characters.

If you install Version 8.1 into a different directory than your Version
7.1 installation, remember to update your environment settings to
point to the new installation directory.

The Relational Storage Manager is not available in version 8.1
The Relational Storage Manager (RSM) is withdrawn from Version 8.1.
If you are upgrading from DB2 OLAP Server Version 7.1 or prior, and
you have applications that use the RSM, you must migrate them to
the Multidimensional Storage Manager (MSM) before installing DB2
OLAP Server Version 8.1, or you will lose data. See “Migrate from
RSM to MSM before upgrading to Version 8.1” on page 25 for more
information.

During installation you are asked what edition and options you purchased.
This information is used to build a license key for DB2 OLAP Server.
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Installation steps
To install and set up DB2 OLAP Server on Windows:
1. Insert the DB2 OLAP Server CD into the CD-ROM drive to start the

installation program. If the program does not start automatically, you can
run setup.exe from the root directory.

2. Click Next. To cancel installation at any time, click Cancel. To display
Help at any time, press F1.

3. Press Accept to accept the Software License Agreement.
4. On the Select Installation Options panel, make sure Client and iSeries

Enabled are selected, and click Next.
5. Select the language you want and click Next.
6. On the Choose Destination Location panel, enter the drive and directory

where you would like to install the clients for DB2 OLAP Server for
iSeries, and click Next. If you are doing a network installation of the
OLAP clients, network drives will also be displayed in the Drive
drop-down menu. IBM strongly recommends that you install the clients
for DB2 OLAP Server for iSeries into a new separate directory; do not
install into directory in which a product other than DB2 OLAP Server for
iSeries has been installed.

7. On the Select Installation Type panel, you must select Custom to enable
the EIS, Warehouse Manager, and Warehouse Builder clients, as well as
other client components and documentation, to be installed.

8. On the Select Components panel, select the clients and documentation
you want to install. Open the tree views for Client and Server
Documentation and Integration Server Documents to see which books
you can install.

9. Enter a name for the folder into which the clients are installed, or accept
the default. Click Next.

10. Click next to start copying the files to your computer. You might need to
restart your computer after the files are copied.

Network Protocol Files
Network protocol files implement the TCP/IP protocol that you select when
you install OLAP client software. The network protocol file for server
software is essnet.dll. Additionally, the client software (for example, Essbase
Spreadsheet Add-in) is installed with a separate essnet.dll. Network protocol
files reside in the bin directory with the DB2 OLAP Server program files.
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Installing DB2 OLAP Server Miner on Windows

DB2 OLAP Server Miner, also called OLAP Miner, is a new no-charge feature
of DB2 OLAP Server that brings together IBM’s data mining and OLAP
technologies. OLAP Miner applies a sophisticated data mining algorithm
called Deviation Detection to the data stored in OLAP cubes. The algorithm
scans slices of cubes, identifying values that deviate from the norm. The
results of a data mining run can be used by the business analyst to focus on
the interesting or surprising values in context of the source OLAP cube. You
can still use the usual slice, dice, and drill operations to explore the data, but
now you let the values discovered by OLAP Miner drive your analysis. See
the OLAP Miner User’s Guide for information about what OLAP Miner can do
for you.

OLAP Miner requires the DB2 OLAP Server API to be installed on the
Windows computer on which you install the OLAP Miner server. Java is a
requirement for OLAP Miner.

OLAP Miner has server and client components that run on Windows only.
You can install the OLAP Miner client on the same computer as the OLAP
Miner server or on another computer.

To install OLAP Miner on Windows:
1. Insert the DB2 OLAP Server Client installation CD into your CD-ROM

drive.
2. Find the OLAP_Miner\win32 directory on the CD.
3. Run the setup.exe file to begin the installation program.
4. The installation program prompts you for the following information:

v If you are installing the OLAP Miner server, you need
– The alias name of the OLAP server you will examine with OLAP

Miner.
– The host address (or IP address) of the server component of DB2

OLAP Server for iSeries. The address is added to the
bin\omclient.cfg file.

v If you are installing the OLAP Miner client, you need the host address
(or IP address) of the Windows computer on which the OLAP Miner
server is installed.

You can set up a silent installation so your users do not have to type
responses to the prompts of the installation program. To set up a silent
installation:
1. Record your responses to the OLAP Miner installation program prompts.

To record your responses, run the following command:
setup.exe -r
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This will record your responses to the installation prompts into a file
called setup.iss, which is stored in the main Windows directory. On
Windows NT and Windows 2000 the files is stored in c:\WINNT, and on
Windows 98, the file is stored in C:\Windows.

2. Copy the setup.iss file into a temporary directory on the computer on
which you are installing OLAP Miner.

3. To run the silent installation, run the setup.exe command using the –s
parameter (for silent installation) and the –f1 parameter (which indicates
the location of the setup.iss file). For example, if you stored the
setup.iss file in the C:\TEMP directory, enter the following command:
setup.exe -s -f1C:\TEMP\setup.iss

Setting up client installation from a network file server

DB2 OLAP Server Version 8.1 offers your enterprise the option of installing
the OLAP client components from a shared network file server. The
alternative is to install them locally, one at a time, directly from the CD.

You cannot install Warehouse Manager or Warehouse Builder client
components from a network. Only OLAP clients are supported by this option.

Installing OLAP clients over a network has the following advantages over
locally installed clients:
v The users in your enterprise can all use the same level of client.
v You can deploy clients to larger numbers of users at the same time, which

is often faster than passing a CD from user to user.
v You can apply FixPaks to the common client code and have your users

upgrade together.
v The network clients take up less disk space than locally installed clients.

Although network clients offer the same function as locally installed clients,
there are important difference between them:

Locally installed clients
Locally installed clients are installed directly from the CD. They
include all the client executable files. The installation program adds
Start menu shortcuts, updates the Windows registry, and updates
environment variables. Because client operations are completely local
and do not load or interpret code over a network, local clients might
offer better performance than network clients.

Network clients
Network clients are installed from a file server. They do not include
any executable files, and therefore take up less room and store fewer
files than locally installed clients. The installation program adds Start
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menu shortcuts, updates the Windows registry, and updates
environment variables. Network clients all use the same language and
connect to the server using the same network protocol.

The network client feature installs clients of DB2 OLAP Server and DB2 OLAP
Integration Server. OLAP Miner clients are not enabled for network
installation; they must be installed directly from the CD.

There are two major steps in setting up a network installation, and they are
performed by two different users:
1. The system administrator runs the DB2 OLAP Server installation program

to load the client image onto the file server. The computer from which the
system administrator does this is called the image owner computer. The
client image consists of executable files plus a second installation program
that your network client users can run to install the network clients. See
“Loading the client image onto the network”.

2. The network client users install the network clients by running the second
installation program. See “Installing the clients from the network” on
page 63.

Loading the client image onto the network
The instructions in this section are intended for the system administrator, who
loads the common client image onto the network.

Before you begin, you need to designate one client computer as the client
image owner, and decide which user ID you will use to load the client image:
v The image owner computer should not be one that is likely to be removed

from the system. If the image owner computer crashes or is removed from
the system, the network client users can continue running the clients, but
the system administrator must take extra steps to apply FixPaks. See
“Maintaining the common clients” on page 63 for more information.

v The user ID with which the image owner computer accesses the file server
must have administrator authority and read/write privileges on the file
server.

You can have the server components on the same file server as the common
client image as long as they are not installed in the same directory.

To load the client image onto the network:
1. Connect to the file server. Whatever drive letter you assign will be the

same drive letter that the network client users must use when they
connect to the file server. For example, if you designate the file server as
the p: drive, the network client users have to connect the file server as
their p: drive.
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2. Insert the DB2 OLAP Server CD into the CD drive on the computer that
you designate as the client image owner computer. If the installation
program does not start automatically, run the setup.exe file in the \Win32
directory of the CD.

3. On the IBM DB2 OLAP Server Setup panel, click Next.
4. On the Software License Agreement panel, read the licence terms. If you

accept them, click Accept.
5. On the Select Installation Options screen, select Client and Store

executables on network, and then click Next.
6. Select the language you want and click Next.
7. On the Choose Destination Location screen, select the drive letter of the

file server from the Drive box.
8. In the Directory field, either accept the default value or click Browse to

select a different path name. Click Next.
9. On the Select Installation Type panel, select either Typical, Compact, or

Custom. You must select Custom to install the clients for EIS; the
Warehouse Manager and Warehouse Builder clients cannot be installed
this way.
It is recommend that you select Custom so you can select which online
books are installed with the network client. If you choose Typical or
Compact, the installation program only installs a small subset of the
documentation.
If you selected Custom, the Select Components panel appears. Open the
Client and Server Documentation item in the tree view and select the
documentation you want to make available to the network client users. It
is recommended that you select all the documentation the network client
users will need.
Click Next.

10. On the Select Folder panel, either accept the default name of the folder or
enter a new one. Click Next.

11. On the Start Copying Files panel, click Next. The network client image is
copied to the file server.

The next step is to inform the network client users how they can install the
network clients. They need the following information:
v The drive letter that you selected when loading the client image onto the

file server. The network client users must select the same drive letter when
they connect to the file server.

v The directory on the file server that contains the installation program for
the network clients.

v The path of the OLAP server components. The path is set in the
ARBORPATH variable.
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The next section, “Installing the clients from the network”, describes how this
information is used when installing the network clients.

Installing the clients from the network
The instructions for installing clients from the network are in the netinst.htm
file, which is in the same directory as the client image installation file. Ensure
your users can access these directions.

Maintaining the common clients
IBM FixPaks for DB2 OLAP Server can apply service upgrades to the client
image stored on the file server.

The following steps describe how to to apply FixPaks for common clients:
1. The system administrator logs on to the image owner computer.
2. The system administrator connects to the file server using the same user

ID under which the common client image was originally loaded onto the
file server.

3. The system administrator runs the FixPak installation program.
4. The network client users connect to the file server and run the updated

netinst.exe file to apply the FixPak to their computers. If there are new
client products in the client image, then they will be added to the your
computer. If clients were removed from the file server, then they will be
removed from your computer.

If the image owner computer crashes or is removed from the system, the
network client users can continue running the clients. However, the system
administrator cannot apply FixPaks without first taking the following steps:
1. Designate a new client image owner computer.
2. Remove the common client image from the file server.
3. Reinstall the original network client image from the new client image

owner computer.
4. Apply the FixPak as described in this section.

Adding additional client software later

If you install DB2 OLAP Server for iSeries and later want to add more
features, select one of the following methods:
v Select Modify Component or License Information from the Start —"

Programs —" IBM DB2 OLAP Server 8.1 - iSeries menu.
v Run the SETUP.EXE program either from the root directory or from the

CD-ROM.
v Use the Windows Add/Remove Software utility, which is available from the

Control Panel.
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Configuring the Spreadsheet Add-ins

If you have Microsoft Excel or Lotus 1-2-3 on your Windows computer when
you install the Spreadsheet Add-in clients, the DB2 OLAP Server installation
program automatically configures your spreadsheet program with the
Spreadsheet Add-ins.

But if you reverse the order of installation (installing DB2 OLAP Server for
iSeries and then installing a spreadsheet program), you must configure your
Spreadsheet program manually. To configure a spreadsheet program
manually:
v From the Start —" Programs —" IBM DB2 OLAP Server 8.1 - iSeries

menu, select Modify Component or License Information.
v Select Modify on the Maintenance panel and click Next.
v On the Modify Entry panel, click Configure Spreadsheet Add-in and click

Next.

The installation program configures your spreadsheet program with the
Spreadsheet Add-in.
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Chapter 7. Connecting to Essbase/400 OLAP server

This chapter describes how to connect to the Essbase/400 (OLAP) server.

Connecting to OLAP server

Before connecting to the OLAP server, use the WRKACTJOB command to verify
that the server is running. The server job will have a name identical to the job
description name, a job type of BCH, and a function of PGM-ESSBASE.
Applications run under separate jobs with the job name identical to the
application name and a job type of BCI. For instructions on starting the server,
see the Administrator’s Guide for OLAP on iSeries.

To connect to Essbase/400 OLAP Server from Application Manager:
1. Open the Application Manager.
2. On the Server menu, choose Connect.
3. In the Essbase System Logon dialog box, enter or select the TCP/IP

address or the host alias name of your Essbase/400 server in the Server
drop-down list.

4. Enter your user name and password, and click OK.
5. If your logon is successful, your computer is ready to use the Essbase/400

server. If your logon fails, see “Troubleshooting Essbase/400 connection
failures” on page 70.

Connecting to the EIS server

The following sections list important notes for using DB2 OLAP Integration
Server for iSeries. DB2 OLAP Integration Server for iSeries is also called
Essbase/400 Integration Server and is abbreviated as either OIS or EIS.

Before connecting to the Essbase/400 Integration Server, use the WRKACTJOB
command to verify that the server is running. The server job will have a name
identical to the job description name, a job type of BCH, and a function of
PGM-OLAPISVR. For instructions on starting the server, see the Administrator’s
Guide for OLAP on iSeries.

ODBC Data Source Name
You do not need to configure an ODBC data source on your client PC to use
EIS. The Essbase/400 Integration Server offers complete DB2/400 Relational
Database support via SQL CLI. Any iSeries system may have a number of
relational databases defined, and these databases may be local or remote. To
find a list of defined databases in the Relational Database Directory, use the
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iSeries WRKRDBDIRE command. You should have at least one Database entry
defined on your iSeries system for EIS to work properly.

Library List
Your library list is determined by the library list of the job description. Before
starting EIS, be sure to update libraries in the job description. You can use the
CHGJOBD command and alter the INLLIBL parameter.

OLAP metadata catalog setup

Your first EIS task is to create an OLAP Metadata Catalog. An OLAP
Metadata Catalog stores the OLAP models that you create and the
metaoutlines that you build from the OLAP models. Until the Metadata
Catalog is created, login attempts will return errors.

When you complete installation of DB2 OLAP Integration Server and start
Essbase Integration Services Console, the program automatically displays the
OLAP Metadata Catalog Setup dialog box, as in Figure 4.

Figure 4. OLAP Metadata Catalog Setup dialog box
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When creating catalogs on the iSeries, use the following information.

Server Name
Enter the Essbase/400 IP address. The Essbase/400 Integration Server
uses the same IP address as the Essbase/400 OLAP Server. To find
your IP address, use the iSeries DSPESSENV command.

ODBC Data Source Name
Once you type an IP Address for the Server Name, Essbase/400
Integration Server will return all the entries it can find in the system
Relational Database directory. Each of these entries is considered an
ODBC data source. Select a data source name whose Remote Location
entry is defined as *LOCAL on the iSeries system. EIS uses the
Essbase/400 installation library as the default collection.

User Name and Password
Specify a valid iSeries user name and password for the EIS
connection. You do not have to create a separate EIS user name and
password.

All the catalog tables will be created in your server installation library. You
can have only one catalog on the iSeries.

Essbase/400 Integration Services login

The Essbase/400 Integration Server manages access to OLAP Metadata
Catalogs and to relational data sources. An OLAP Metadata Catalog stores
information that defines the relational data source and the structure of OLAP
model and metaoutline elements. To create an OLAP model or a metaoutline,
you must first connect to Essbase/400 Integration Server.

When connecting to the server, you will use the EIS Login dialog box, as in
Figure 5 on page 68.
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When connecting to EIS on the iSeries, use the following information.

Server Enter the Essbase/400 IP address. The Essbase/400 Integration Server
uses the same IP address as the Essbase/400 OLAP Server. To find
your IP address, use the iSeries DSPESSENV command.

OLAP Metadata Catalog
Once you type an IP Address for the Server Name, Essbase/400
Integration Server will return all the entries it can find in the system
Relational Database directory. Each of these entries is considered an
ODBC data source. Select a data source name whose Remote Location
entry is defined as *LOCAL on the iSeries system. EIS uses the
Essbase/400 installation library as the default collection.

User Name and Password
Specify a valid iSeries user name and password for the EIS
connection. You do not have to create a separate EIS user name and
password. Note: When connecting to the Essbase/400 OLAP Server
(using the right-hand side of the dialog box), you must also provide a

Figure 5. EIS Login dialog box
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valid Essbase user name. For instructions on using your OS/400 user
profile and password to log into Essbase/400 OLAP Server, read
about Integrated Security in the Administrator’s Guide for OLAP on
iSeries.

Setting up the EIS sample application

EIS provides a sample application for a fictitious company, The Beverage
Company (TBC). Creating the sample application is not required, but it may
provide valuable insight for the novice users. Instructions for setting up the
sample application are in the Hyperion Essbase Integration Services
Installation Guide.

Before you begin the setup, the system administrator must create an OS/400
user profile called TBC for sample application maintenance. This is the only
profile that is allowed to create or delete the sample application. In the
Sample Application Setup dialog from the Essbase Integration Services
Console (which is available from the Tools menu), you will notice that the
user name (TBC) is read-only and cannot be changed. See Figure 6.

Figure 6. Sample Application Setup dialog box
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Troubleshooting Essbase/400 connection failures

Problem: In the Application Manager Essbase System Logon dialog box, no
servers appear in the Server drop-down list.

Solution. Originally, the server IP or hostname must be manually
entered in the Server drop-down list. After a valid connection is
established, the server IP and hostname are stored.

Problem. The following error message is displayed: Network Error (10060):
Unable to Connect to (x.x.x.x). The client timed out waiting to connect to the
Essbase Agent using TCP/IP.

Solution. Verify your TCP/IP address. Run the DSPESSENV
INFO(*ALL) command in an Essbase server library and check the
second-level text of the Essbase/400 Server attributes error message.
This will display the Essbase Server TCP/IP address.

Problem. The following error message is displayed: Error 1042017: The
client or server timed out waiting to receive data using TCP/IP.

Solution. Create or edit the NETDELAY & NETRETRYCOUNT
settings in the .cfg file to override the default settings. The .cfg file
resides in the Essbase library on the server or in the \bin folder on
your PC (for example, DB2 OLAP Server\bin). The file may reside on
both the server and your PC.

NETDELAY dictates how long (in milliseconds) Essbase waits before
retrying an unsuccessful operation. The default is 200.

NETRETRYCOUNT dictates how many times the network tries to
connect to the host. The default is 600.Increase the values based on
the frequency of the error (the more often the error occurs, the larger
the value). For example, increase the value of a less frequent error by
hundreds; increase the value of a more frequent error by thousands.

In addition, consider how many users experience the problem. If only
a few users are affected, change the PC file; if more users are affected,
change the iSeries file. After editing the file, stop and restart
Essbase/400 OLAP Server.
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Chapter 8. Setting Up an ODBC data source for Builder

To set up data sources, use Microsoft ODBC Administrator (odbcad32.exe)
installed with STRATEGY PC software. You can access it via the STRATEGY
group on the Windows Start menu.

Relational components.

Set up a ShowCase ODBC data source on each PC that accesses iSeries
(AS/400) Warehouse Manager Server through STRATEGY applications. You
will need:
v iSeries IP address
v Warehouse Manager library port number

Multidimensional components.

PCs that use only multidimensional query components (Analyzer against
Essbase, Essbase reporting in Query/Report Writer, or the Essbase
Spreadsheet Add-ins) do not require an ODBC data source.

Non-DB2 data sources.

Set up data sources to access the following:
v Microsoft Access and Excel
v Microsoft SQL Server
v Lotus Domino
v Oracle on AIX, Windows NT, or Windows 2000

For non-DB2 data source setup information, see the non-DB2 guides available
from the Start > Programs > IBM DB2 OLAP Server iSeries 8.1 >
Documentation information map.

Adding a ShowCase ODBC data source

You should add a ShowCase ODBC data source if:
v This is your first STRATEGY installation and setup and/or you received the

following message at the end of the PC installation: Setup has not created a
sample ShowCase ODBC data source.

v You installed Warehouse Manager Server to a new library and want to
access both the new and old Warehouse Manager libraries.
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To add a ShowCase ODBC data source:
1. From the Windows Start menu, choose:

Programs
IBM DB2 OLAP Server 8.1 - iSeries

DB2 OLAP Server Builder Clients
Microsoft ODBC Administrator

2. Click Add.
3. In the Create New Data Source dialog box, select ShowCase ODBC and

click Finish.

Figure 7. Microsoft ODBC Data Source Administrator dialog box
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4. Enter a data source name. Adding a description is optional.

Note: If you are sharing queries, using the same data source name on all
PCs will make sharing queries easier for novice users.

5. Enter your iSeries (AS/400) IP address.
6. Enter your Warehouse Manager Server TCP port number. The default is

43419.

Note: If you do not know the TCP port number, use the iSeries (AS/400)
WRKSRVTBLE command and search for SCSERVERlibname where
libname is the Warehouse Manager Server library name.

7. Click OK.

Modifying a ShowCase ODBC data source

You can modify a ShowCase OCBC data source if Warehouse Manager Server
was installed to a new library and you do not want to access the old
library—or if you need to change your data source name, IP address, or TCP
port number.

To modify a ShowCase ODBC data source via Microsoft ODBC
Administrator:

1. From the Windows Start menu, choose:
Programs

IBM DB2 OLAP Server 8.1 - iSeries
DB2 OLAP Server Builder Clients
Microsoft ODBC Administrator

Figure 8. ShowCase ODBC Setup dialog box
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You will see a screen similar to Figure 7.
2. Select the data source that you want to modify and click Configure.

A ShowCase ODBC Setup dialog box similar to Figure 8 appears.
3. Modify the ODBC setup information as necessary.
4. Click OK.

To modify a ShowCase ODBC data source via AS/400 Test Connection:
1. From the Windows Start menu, choose:

Programs
IBM DB2 OLAP Server 8.1 - iSeries

DB2 OLAP Server Builder Clients
iSeries Test Connection

2. Select the data source that you want to modify.
3. Click Setup and change the information, as necessary.
4. Click OK.
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Chapter 9. Connecting to Warehouse Manager server

You can connect to Warehouse Manager Server with any of the STRATEGY
PC products or with the AS/400 Test and Configure application.

Connecting with clients applications

1. To open a client application, from the Windows Start menu, choose:
Programs

IBM DB2 OLAP Server 8.1 - iSeries

Warehouse Builder
1. Open Warehouse Builder and select a data source to use as a control

server. This is the Warehouse Manager Server library in which you want to
store your distribution definitions. Click OK.

2. If you have not specified a default data source, Warehouse Builder will
prompt you to select one. Select a data source and click OK.

3. In the ShowCase ODBC Logon dialog box, enter your iSeries user ID and
password and click OK.

4. If your logon is successful, the Warehouse Builder Assistant dialog box
appears and your PC is connected to Warehouse Manager Server. If your
logon is not successful, see “Connecting with the iSeries test and configure
application”.

Warehouse Manager Client
1. Open Warehouse Manager Client and select the data source to which you

want to connect.
2. On the File menu, choose Connect, or click the Connect tool.
3. In the ShowCase ODBC Logon dialog box, enter your iSeries user ID and

password and click OK.
4. If your logon is successful, your user ID appears in parentheses after the

data source and your PC is connected to Warehouse Manager Server. If
your logon is not successful, see “Connecting with the AS/400 Test and
Configure Application” below.

Connecting with the iSeries test and configure application

The iSeries Test and Configure application tests the ODBC data source setup.
Use it to:
v Verify your connection to the correct system and library.
v Add, edit, or remove a ShowCase data source.

© Copyright IBM Corp. 1998, 2002 75



The Test and Configure application does not test the special checks made
when STRATEGY software connects to the iSeries (AS/400). That is, there are
times when Test and Configure will connect but a product will not, such as
when a user is not authorized to use a product or when an application
password has expired.

To open the iSeries Test and Configure application
1. From the Windows Start menu, choose:

Programs
IBM DB2 OLAP Server 8.1 - iSeries

DB2 OLAP Server Builder Clients
iSeries Test Connection

Troubleshooting Warehouse Manager connection failures

v Verify your IP address:

Use the Microsoft ODBC Administrator to determine whether your IP
address is valid.
At the MS-DOS prompt, type PING ipaddress, where ipaddress is the IP
address you want to use.
If you receive a reply similar to Reply from 172.16.1.84: bytes=32
time=84ms TTL=64, your IP address is valid and the TCP/IP connection is
working.
If you receive the message Request timed out, your IP address may be
incorrect or TCP/IP may not be configured correctly on either your PC or
the server.
For more information, see Chapter 8.

v Verify your library port number:

At the iSeries command line, type WRKSRVTBLE and press Enter.
In the Port column, look for the port number you want to use. The port’s
service entry should be OLAPBLDSVR serverlib, where serverlib is the name
of the Warehouse Manager Server library. If you do not find the port, look
for the correct library name under Service and check the correct port
number for that library.

v Verify that IBM TCP/IP is active on your iSeries:
At the iSeries command line, type WRKACTJOB JOB(QTCPIP) and press Enter.
If you cannot find the job, type the STRTCP command and press Enter to
start TCP/IP on the server.
For more information on starting and stopping TCP/IP, see the
Administrator’s Guide for Builder on iSeries.

v Verify that the TCP/IP master job has started on the server:
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At the iSeries command line, type WRKACTJOB JOB(serverlib), where
serverlib is the name of the Warehouse Manager Server library, and press
Enter.
There should be an entry in the subsystem/job column with the same name
as the library in which Warehouse Manager Server is installed. Use option 5
to work with this job and then option 11 to display the call stack. The
program TCPMASTER in the library containing the installation should be
the first program on the stack (use F11 to change the display until you see
the program and library names).
For more information on using TCP/IP with STRATEGY, see the
Administrator’s Guide for Builder on iSeries.

v If IBM TCP/IP and the TCP/IP master job are both active, complete the
steps listed below:
1. At the iSeries command line, type:

CHGJOBD JOBD(serverlib/SCTCPSRV) LOG(4 00 *SECLVL) LOGCLPGM(*YES)

where serverlib is the name of the library in which Warehouse Manager
Server is installed.

2. Run the following iSeries commands to attempt a connection test, and
note the iSeries system date and time:
DSPSYSVAL SYSVAL(QDATE)
DSPSYSVAL SYSVAL(QTIME)

3. To view spooled files in the QUSER spooled file list, type the iSeries
command WRKSPLF SELECT(QUSER).

4. Press F6 to go directly to the bottom of the spooled list. There should be
a spooled file named QPJOBLOG with a user data attribute of SCTCPSRV.
Press F11 until the display shows the creation date and time. Look for
the date and time of the connection failure. If you find a matching
spooled file, skip the next two steps and resume the process.

Note: Almost all connection failure job logs can be found in the QUSER
spooled file list. However, certain types of errors may suddenly
terminate the connection directly after the initial connection is
complete, and thus the job log may be in the profile’s spooled file
list. To find the spooled file for the ODBC profile, complete the
next step.

5. If you do not see a spooled file matching the date and time of the
connection failure in the QUSER spooled file list, use the iSeries command
WRKSPLF SELECT(odbcprofile), where odbcprofile is the iSeries user
profile specified in the connection dialog box.

6. Repeat the step beginning with “Press F6.”
7. Use option 5 to display the spooled file from the spooled file list. Page

down and look for messages indicating the cause of the connection
failure.
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8. If you need help in determining the cause of the connection failure,
contact ShowCase Support. A copy of the job log for the failing
connection will help to diagnose the connection failure.

Note: Once the connections are working, run the following command to
avoid generating job logs for all connections:
CHGJOBD JOBD(serverlib/SCTCPSRV) LOG(4 00 *NOLIST) LOGCLPGM(*NO)

where serverlib is the name of the library in which the server is
installed.
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Chapter 10. Installing Essbase/400 sample applications

When you install Essbase/400 Application Manager samples on your PC, the
files required to create the sample databases are copied into the
ARBORPATH\APP folder on your hard drive. After a network installation,
you can find the files in the ARBORPATH\APP folder on the network. After
installation, you must create the sample applications and databases and
prepare them for use. This appendix explains these procedures.

Note: It is assumed that the samples and references to the sample
applications in the Essbase/400 documentation set are installed from a
server. However, the sample applications shipped with Essbase/400 are
installed from a client PC. Therefore, be sure to specify the location of
the applications accordingly. In most cases, select the Location group
box of a given dialog box and choose the Client option.

Essbase/400 includes six sample applications that can be installed on your
server.

Demo Contains one database—Basic—referred to in the Technical Reference.

Sample
Contains one database referred to throughout the Essbase/400
documentation set as Basic. The spreadsheet user guides provide a
step-by-step tutorial through the spreadsheet clients.

Samppart
The first of two applications designed to show the features of
Essbase/400 partitioning. Samppart contains the Company database that
is the target of a partitioned database.

Sampeast
The second of two applications designed for Essbase/400 partitioning.
Sampeast contains an East database, the source of data for a
partitioned database.

Note: To use the Samppart and Sampeast applications, your Essbase/400
Server must be registered with a license number supporting
partitioning.
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Creating the Sample Applications

This section explains how to set up the framework of Essbase/400 sample
applications. The following instructions do not load or calculate the databases.
For that information, see “Loading and calculating the sample databases” on
page 86.

Complete the following six steps for each application.
1. Make sure that you know:

v The Essbase/400 Server is running
v The server’s TCP/IP address
v A valid user ID and associated password

2. To connect to the Essbase/400 Server, from the Essbase/400 Application
Manager menu, choose:
Server

Connect

The Connect dialog box requires the TCP/IP alias name or address, and a
user ID and password.

3. To create a new application on the server, from the menus, choose:
File

New
Application

Give the application the appropriate sample name: Sample, Demo, Samppart,
Sampeast, Drinks, or Scsample.

4. To create a new database for the application, choose:
File

New
Database

Name each database as follows:

Application name Database name

Sample Basic

Demo Basic

Samppart Company

Sampeast East

5. Move the sample database outline to the Essbase/400 Server. For
instructions, see “Moving objects from the client to Essbase/400 server” on
page 81. In these instructions, for file type, select Outlines (.otl). Select the
outline with the same name as the database that you are creating. See the
following table:
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Application/database name Outline name

Demo Basic Basic

Sample Basic Basic

Samppart Company Company

Sampeast East East

6. To continue creating the sample databases, follow the instructions below
for the appropriate database:

Demo Basic
Move the report scripts of the Demo Basic database to Essbase/400
Server. For instructions, see “Moving Objects from the Client to
Essbase/400 Server” below. In these instructions, for Files of Type,
select Report Scripts (.rep). Repeat the instructions (opening and
saving) for all report scripts in the folder.

Sample Basic
Move the rule objects of the Sample Basic database to Essbase/400
Server. For instructions, see “Moving Objects from the Client to
Essbase/400 Server” below. While following these instructions, for
Files of Type, select Rule Objects (.rul). Repeat the instructions
(opening and saving) for all rule objects in the folder.

Samppart Company
Follow the instructions in “Setting up the environment for
Samppart and Sampeast” on page 83, and then load and calculate
the database with the instructions in “Samppart Company” on
page 88.

Sampeast East
Follow the tasks in “Setting up the environment for Samppart and
Sampeast” on page 83, and then load and calculate the database
with the instructions in “Sampeast East” on page 89.

Moving objects from the client to Essbase/400 server

This section helps you move outlines, calculation scripts, rule objects, and
report scripts from the client to Essbase/400 Server.

To move an outline, calculation script, rule object, or report script, you must
complete all steps in “Opening the object” and “Saving the object” on page 82
for each object.

Opening the object
When opening an outline file in Application Manager, you may get an error
message indicating that long filenames are not supported. To solve this
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problem, move the client folder containing your outlines, calculation scripts,
report files, and rules files (for example, ARBORPATH\APP) to your root
folder.
1. From the Essbase/400 Application Manager menu, choose:

File
Open

The Open Object dialog box appears.
2. In the Location group, select Client.
3. In the Application box, select the application for which you want to move

an outline, calculation script, rule object, or report script.
4. In the Database box, select the database for which you want to move an

outline, calculation script, rule object, or report script.
5. Click File System. The Open Client File dialog box appears.
6. Navigate to the folder in which you installed the sample applications (for

example, ARBORPATH\APP).
7. Click the folder corresponding to the sample database that you are

creating: Demo, , Sampeast, Sample, or Samppart.
8. In the Files of Type box, select the file type of the object that you want to

move: Outlines (.otl), Calc Scripts (.csc), Rule Objects (.rul), or Report
Scripts (.rep).

9. Select the file to move and click Open.

Saving the object
1. From the File menu, choose Save As. The Save Object dialog box

appears.
2. In the Location group, select Server.
3. In the Server box, select the TCP/IP name or address of the server to

which you want to move the outline, calculation script, rule object, or
report script.

4. In the Application box, select the application for which you are saving
the outline, calculation script, rule object, or report script.

5. In the Database box, select the database for which you are saving the
outline, calculation script, rule object, or report script.

6. In the List Objects of Type box, select the appropriate object: Outlines,
Calc Scripts, Rule Objects, or Report Scripts.

7. In the Object Name box, type the object name of the outline, calculation
script, rule object, or report script that you are saving.

8. Click OK.
v If Essbase/400 displays a message indicating that the object already

exists and asks if you would like to replace the existing object, click
Yes.
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v If Essbase/400 displays a message indicating that the object is
unlocked and asks if you would like to replace the existing object, click
Yes.

v If Essbase/400 displays a message indicating that the object did not
originate from the latest version of the server and that you could lose
data and then asks if you want to continue, click Yes.

9. Close the appropriate window: outline viewer, calculation script editor,
rule object editor, or report script editor.

10. To finish creating the Demo Basic, Drinks Demo, Sample Basic, or Scsample
Sales databases, you must load the data. The following table indicates
where to find the instructions to load data into the sample database that
you are creating.

Database name Reference

Demo Basic “Demo Basic” on page 86

Sample Basic “Sample Basic” on page 87

Setting up the environment for Samppart and Sampeast

Essbase/400 includes two sample applications and databases that show the
features of partitioning: Samppart Company and Sampeast East. They include
partition definitions stored in .ddb files.

The .ddb files define the map between member combinations in the target
database (Company) and the source database (East). For instructions on setting
up partitions, see the Database Administrator’s Guide. This guide also explains
member combinations and the differences between target and source
databases.

For these applications to work in your environment, you must match or
change the information contained in the .ddb files. To use the applications, do
the following:
v Create the user name that designed the applications.
v Change the server name embedded in the applications.

Note: Do not physically change the .ddb file information. Instead, complete
the steps in the following sections. “Creating the Partition User”
describes how to create the user name so your users can use these
applications. “Changing the server name in sample partition
definitions” on page 84 describes how to change the embedded server
name to the name of your Essbase/400 Server.
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Creating the partition user
Because the Samppart and Sampeast applications were designed by a user
called partitionuser, you must create a user called partitionuser to work with
these applications. Partitionuser must have Application Designer access to
these applications on the server where they are installed. If you are unsure
how to create a user and you use the Integrated Security feature of
Essbase/400, see the Administrator’s Guide for OLAP on iSeries. If you do not
use Integrated Security, complete the following steps:
1. From the Essbase/400 Application Manager menu, choose:

Server
Connect

2. Connect to the server with the Samppart and Sampeast applications. Log
on as a user that has supervisor privilege.

3. From the Security menu, choose Users/Groups.
4. In the User/Group Security dialog box, click the New User button to

open the New User dialog box.
5. In the Username box, enter partitionuser, using lowercase letters.
6. In the Password box, enter a password.
7. In the Confirm Password box, type your password again.
8. Click the App Access button to open the User/Group Application Access

dialog box.
9. Select the Sampeast application, and then select App Designer in the

Access group box.
10. Select the Samppart application, and then select App Designer in the

Access group box.
11. Double-click OK to return to the User/Group Security dialog box.
12. Click Close.
13. From the Server menu, choose Disconnect to log off of the server. Click

OK.
14. From the Server menu, choose Connect and log on as partitionuser. The

Application Desktop window appears. You are ready to continue setting
up the Samppart and Sampeast applications. See “Changing the server
name in sample partition definitions”.

Changing the server name in sample partition definitions
The following steps change the embedded server name in the partition
definition files (.ddb) to the Essbase/400 Server name. The .ddb files shipped
with Samppart and Sampeast are based on the server name Localhost.

Note: You must complete the steps in “Creating the partition user” before
continuing.
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Changing the server name for the Samppart Company database
The following steps change the server name in the Samppart Company .ddb file.
1. In the Application Desktop window, select the Samppart application and

Company database.
2. From the Database menu, choose Partition Manager to open the Partition

Manager dialog box.

Note: If the Partition Manager dialog box does not appear or if it does
not contain definition entries, contact your Essbase/400 system
administrator. Your Essbase/400 Server must be registered with a
license number that supports partitioning.

3. In the Source Cube list, select the first definition
entry—Localhost:Sampeast:East.

4. Click Edit. The Dangling Remote Reference dialog box appears. Because
you are not connected to a server named Localhost, Essbase/400 is
warning you before it allows you to edit the definition.

5. Click Advanced. The Fix Dangling Partition Reference dialog box
appears.

6. In the Action group, select Correct the invalid partition reference.
7. In the Reconnect group, in the Server text box, replace Localhost with the

name of your Essbase/400 Server (for example, ESSBASE).
8. Click Apply. You are returned to the Partition Manager dialog box.
9. In the Source Cube list, select the second definition

entry—Localhost:Sampeast:East.
10. Repeat the four steps beginning with “Click Edit” and ending with

“Click Apply.”
11. In the Target Cube list, select the first definition

entry—Localhost:Sampeast:East.
12. Repeat the four steps beginning with “Click Edit” and ending with

“Click Apply.”
13. From the Partition menu, choose Close to return to the Application

Desktop window.

You have successfully changed the server name in the Samppart Company .ddb
file.

Changing the Server Name for the Sampeast East Database
The following steps change the server name in the Sampeast East .ddb file.
1. In the Application Desktop window, select the Sampeast application and

East database.
2. From the Database menu, choose Partition Manager to open the Partition

Manager dialog box.
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3. In the Source Cube list, select the first definition
entry—Localhost:Samppart:Company.

4. Click Edit. The Dangling Remote Reference dialog box appears. Because
you are not connected to a server named Localhost, Essbase/400 is
warning you before it allows you to edit the definition.

5. Click Advanced. The Fix Dangling Partition Reference dialog box
appears.

6. In the Action group, select Correct the invalid partition reference.
7. In the Reconnect group, in the Server text box, replace Localhost with the

name of your Essbase/400 Server (for example, ESSBASE).
8. Click Apply. You are returned to the Partition Manager dialog box.
9. In the Source Cube list, select the first definition

entry—Localhost:Samppart:Company.
10. Repeat the four steps beginning with “Click Edit” and ending with

“Click Apply.”
11. In the Target Cube list, select the second definition

entry—Localhost:Samppart:Company.
12. Repeat the four steps beginning with “Click Edit” and ending with

“Click Apply.”
13. From the Partition menu, choose Close to return to the Application

Desktop window.

You have successfully changed the server name in the Sampeast East .ddb file.

Note: When you have completed the instructions in “Setting up the
environment for Samppart and Sampeast” on page 83, you can continue
building the Samppart or Sampeast databases. See “Samppart
Company” on page 88 or “Sampeast East” on page 89.

Loading and calculating the sample databases

Now that you have created the new application and database for the sample
database and saved any necessary rule files or report scripts on the server,
you are ready to load the data into the database and calculate it. The
following sections will cover loading and calculating each sample database.

Demo Basic
The Demo application contains one database called Basic. To prepare it for
use, you must load and calculate the data.

Note: When loaded, the Demo Basic database uses approximately 2MB of disk
space on the server, in addition to the size of the data source file.

1. From the Essbase/400 Application Manager menu, choose:
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Server
Connect

2. Connect to the server on which the Demo application is installed.
3. In the Applications box, select Demo.
4. In the Databases list, select Basic.
5. From the Database menu, choose Load Data to open the Data Load

dialog box.
6. Click Find to locate a data file to load. The Open Server Data File Objects

dialog box appears.
7. In the Location group, select Client.
8. Make sure Text files is selected in the List Objects of Type box.
9. In the Objects list, select DATA.

10. Click OK. The Data Load dialog box is updated to display the data file
that you chose.

11. Click OK to load the selected file. The data file is approximately 660KB.
It will take a minute or two to load, and then the Data Load Completed
dialog box appears.

12. Click Close.

Once the data is loaded into the database, Essbase/400 automatically commits
the data to the disk. You can safely stop the application or server and then
restart it.

Sample Basic
The first database in the Sample application is called Basic. To prepare it for
use, you must load and calculate the data.

Note: When loaded, the Sample Basic database uses approximately 5MB of
disk space on the server, in addition to the size of the data source file.

1. From the Essbase/400 Application Manager menu, choose:
Server

Connect

2. Connect to the server on which the Sample application is installed.
3. In the Applications box, select Sample.
4. In the Databases list, select Basic.
5. From the Database menu, choose Load Data to open the Data Load

dialog box.
6. Click Find to locate a data file to load. The Open Server Data File Objects

dialog box appears.
7. In the Location group of the Open Server Data File Objects dialog box,

select Client.
8. In the List Objects of Type box, be sure that Text files is selected.
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9. In the Objects list box, select CALCDAT.
10. Click OK. The Data Load dialog box is updated to display the data file

that you chose.
11. Click OK to load the selected file. The data file is approximately 3MB. It

will take several minutes to load, and then the Data Load Completed
dialog box appears.

12. Click Close.

Once the data is loaded into the database, Essbase/400 automatically commits
the data to the disk. You can safely stop the application or server and then
restart it.

Samppart Company
After setting up the environment for the Samppart and Sampeast applications
(as described in “Providing user access to the sample applications” on
page 89), you must load data into the database of each application. This
section explains how to load and calculate the Samppart Company data.

Note: When loaded, the Samppart Company database uses approximately 2MB
of disk space on the server, in addition to the size of the data source
file.

1. From the Essbase/400 Application Manager menu, choose:
Server

Connect

2. Connect to the server on which the Demo application is installed. Log on
as partitionuser or as a user with supervisor privilege.

3. In the Applications box, select Samppart.
4. In the Databases list, select Company.
5. From the Database menu, choose Load Data to open the Data Load

dialog box.
6. Click Find to locate a data file to load. The Open Server Data File Objects

dialog box appears.
7. In the Location group, select Client.
8. Make sure Text files is selected in the List Objects of Type box.
9. In the Objects list, select CALCCOMP.

10. Click OK. The Data Load dialog box is updated to display the data file
that you chose.

11. Click OK to load the selected file. The data file is a large, fully calculated
data set. It should take about a minute to load, and then the Data Load
Completed dialog box appears.

12. Click Close.
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Once the data is loaded into the database, Essbase/400 automatically commits
the data to the disk. You can safely stop the application or server and then
restart it.

Sampeast East
After setting up the environment for the Samppart and Sampeast applications
(as described in “Providing user access to the sample applications”), you must
load data into the database of each application. This section explains how to
load and calculate the Sampeast East data.

Note: When loaded, the Sampeast East database uses approximately 1.5MB of
disk space on the server, in addition to the size of the data source file.

1. From the Essbase/400 Application Manager menu, choose:
Server

Connect

2. Connect to the server on which the Demo application is installed. Log on
as partitionuser or as a user with supervisor privilege.

3. In the Applications box, select Sampeast.
4. In the Databases list, select East.
5. From the Database menu, choose Load Data to open the Data Load

dialog box.
6. Click Find to locate a data file to load. The Open Server Data File Objects

dialog box appears.
7. In the Location group, select Client.
8. Make sure that Text files is selected in the List Objects of Type box.
9. In the Objects list, select CALCEAST.

10. Click OK. The Data Load dialog box is updated to display the data file
that you chose.

11. Click OK to load the selected file. The data file is a small, fully calculated
data set. It should take about a minute to load, and then the Data Load
Completed dialog box appears.

12. Click Close.

Once the data is loaded into the database, Essbase/400 automatically commits
the data to the disk. You can safely stop the application or server and then
restart it.

Providing user access to the sample applications

Essbase/400 provides a comprehensive security system for a secure multi-user
environment. By default, the sample applications are created with a security
access level of No Access, which means no user can connect to the database
without supervisor authority.
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The first user on the client is the user name defined when the Essbase/400
Server was installed. This user automatically has supervisor privilege.

To provide all users with write access to the database:
1. From the Essbase/400 Application Manager menu, choose:

Server
Connect

2. Connect to the server on which the sample application is installed.
3. In the Applications box, select the sample application to which you want

to grant access.
4. From the Application menu, choose Settings. The Application Settings

dialog box appears.
5. In the Minimum Database Access group, select Write.
6. Click OK.
7. Repeat the above steps for each sample application to which you want to

give your users access.

At this point, the Essbase/400 sample applications are ready for use. Next,
create the appropriate user IDs and security settings so that your users can
log on to Essbase/400. For more information on Essbase/400 security, see the
Administrator’s Guide for OLAP on iSeries.
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Notices

This information was developed for products and services offered in the
U.S.A. IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
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be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement, or any equivalent
agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

Trademarks

1–2–3 Language Environment
AIX Net.Data
AS/400 Notes
DB2 iSeries
DB2 OLAP Server OS/390
DB2 Universal Database RS/6000
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DRDA S/390
IBM SecureWay
OpenEdition OS/400

The following terms are trademarks or registered trademarks of other
companies:

Lotus and 1-2-3 are trademarks of Lotus Development Corporation in the
United States, or other countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered
trademarks of Microsoft Corporation.

Java or all Java-based trademarks and logos, and Solaris are trademarks of
Sun Microsystems, Inc. in the United States, other countries, or both.

Tivoli and NetView are trademarks of Tivoli Systems Inc. in the United States,
other countries, or both.

UNIX is a registered trademark in the United States, other countries or both
and is licensed exclusively through X/Open Company Limited.

Other company, product, or service names may be trademarks or service
marks of others.
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Glossary

This glossary defines terms that are used in
this book and throughout the IBM DB2
OLAP Server library.

accounts dimension. A dimension type that
makes accounting intelligence available. You can
tag one dimension as an accounts dimension, but
an accounts dimension is not required.

administrator. A person who is responsible for
installing and maintaining DB2 OLAP Server and
for setting up user accounts and security.

agent. A process that starts and stops
applications and databases, manages connections
from users, and handles user-access security.

alias ID table. A table created by DB2 OLAP
Server in your relational database that contains a
mapping of multidimensional alias table names
to ID numbers allocated by DB2 OLAP Server.

alias ID view. A view created by DB2 OLAP
Server in your relational database that contains
one row for each multidimensional alias table
used with a relational cube. There is one alias ID
view for each relational cube.

alias name. An alternate name for a dimension
or member.

anchor dimension. A dense dimension that is
specified as the dimension that DB2 OLAP
Server uses to help define the structure of the
fact table it creates in the relational cube for a
multidimensional database.

API. Application programming interface. The
DB2 OLAP Server API is a library of functions
that you can use in a custom C or Visual Basic
program to access DB2 OLAP Server.

Application Manager. A tool that you can use
to create and maintain OLAP applications.

block. A string of data elements recorded or
transmitted as a unit.

cache. A component of memory. Each
multidimensional database contains a data cache
and an index cache.

calculation. An equation within a database
outline, a calculation script, or a report script
that calculates a value for a particular member or
point in a report.

calculation script. A text file that contains
instructions to perform calculations within a
multidimensional database. Also called a calc
script.

Commit Block parameter. A parameter on the
Transaction page of the Database Settings
notebook in the Application Manager that you
use to set the number of blocks that can be
changed before DB2 OLAP Server commits the
blocks.

cube catalog table. A table that DB2 OLAP
Server creates in your relational database that
contains a list of all the multidimensional
databases that are stored in your relational
database. The cube catalog table also shows the
application with which each cube is associated.
Each time that you create a multidimensional
database, DB2 OLAP Server creates a new row in
this table.

cube catalog view. A view that DB2 OLAP
Server creates in your relational database that
allows an SQL user to access a list of OLAP
applications and relational cubes.

cube table. A table that DB2 OLAP Server
creates in your relational database that contains a
list of dimensions in a relational cube and
information about each dimension.

cube view. A view that DB2 OLAP Server
creates in your relational database that allows an
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SQL user to access the names of all dimensions
in a relational cube and associated information
for each dimension. There is one cube view for
each relational cube in your relational database.

data load. The process of populating a
multidimensional database with data. Loading
data establishes actual values for the values of
the cells defined in the database outline for the
database.

data load rules. A set of operations that DB2
OLAP Server performs on data as it is loaded
from an external source file.

database administrator. A person responsible
for administering a relational database.

database log file. A set of primary and
secondary log files consisting of log records that
record all changes to a database. The database
log file is used to roll back changes for units of
work that are not committed and to recover a
database to a consistent state.

database managed space (DMS). Space in a
table that is managed by the database.

database name. The name of the relational
database where you want DB2 OLAP Server to
store your multidimensional data.

database outline. The structure that defines all
elements of a database within DB2 OLAP Server.
It contains definitions of dimensions and
members, dense or sparse dimension tags and
attributes, the anchor dimension attribute,
calculations, shared members, and alternations to
the basic roll-up structure of the database.

database password. The password for the user
ID that you want DB2 OLAP Server to use to log
on to your relational database.

database section. A section in the Relational
Storage Manager configuration file that contains
values for parameters that override the values
for the same parameters for the current
application.

database settings. Settings that you can modify
to improve performance and space utilization for

your relational database. You can change
database settings by using utilities or commands
supplied with your relational database
management system.

database user ID. The user ID that you want
DB2 OLAP Server to use to log on to your
relational database. The default is the supervisor
ID that you specify when you start DB2 OLAP
Server for the first time.

dense dimension. A dimension with a high
probability for occupying one or more data
points in every combination of dimensions that
occurs.

dimension. A data category, such as time,
accounts, products, or markets. In a
multidimensional database outline, the
dimensions represent the highest consolidation
level.

dimension table. A table that DB2 OLAP Server
creates in your relational database that contains
detailed information about the members in a
dimension. There is one dimension table for each
dimension in an outline.

dimension view. A view that DB2 OLAP Server
creates in your relational database that allows an
SQL user to access information about members
contained in a dimension.

ESSCMD. A command-line interface used to
perform server operations interactively or
through a batch file.

generation name. A unique name that describes
a generation in a database outline.

generation table. A table that DB2 OLAP Server
creates in your relational database that contains
generation numbers and names for each named
generation specified when you created the
outline. There is one generation table for each
dimension in an outline.

level name. A unique name that describes a
level in a database outline.
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member. A discrete component within a
dimension. For example, January 1997 or 1Qtr97
are typical members of a Time dimension.

metaoutline. A template containing the
structure and rules for creating a database
outline from an OLAP model. Using the
metaoutline, you can create a database outline
and load data into it. The DB2 OLAP Integration
Server desktop includes a tool called OLAP
Metaoutline that you can use to create one or
more metaoutlines from an OLAP model.

model. A logical model (star schema) that you
create from tables and columns in a relational
database. You can use the OLAP model to create
a metaoutline that generates the structure of a
multidimensional database. The DB2 OLAP
Integration Server desktop includes a tool called
OLAP Metaoutline that you can use to design
and create an OLAP model based on a relational
data source.

multidimensional data. The data in a
multidimensional database. Data can include
basic data values (loaded from an external
source) that represent combinations of the lowest
level of members in the dimensions of the
database; data values that are calculated from the
base data values; and rolled up data values that
are created by combining values for members in
dimension hierarchies.

multidimensional database. An OLAP database
that you create using the Application Manager or
ESSCMD commands (in DB2 OLAP Server) or
with the DB2 OLAP Integration Server desktop,
which is in the Starter Kit. An OLAP database
includes a database outline, data, associated
optional calculation scripts, optional report
scripts, and data load rules. DB2 OLAP Server
stores the actual data and a shadow of the
database outline in tables in a relational
database.

named pipes. An API used for special
node-to-node applications and particularly for
access to communications and database servers.

OLAP application. An application that you
create using the Application Manager or the

ESSCMD commands (in DB2 OLAP Server) or
with the DB2 OLAP Integration Server desktop,
which is in the Starter Kit. An OLAP application
can contain one or more multidimensional
databases and any associated calculation scripts,
report scripts, and data load rules.

OLAP metaoutline. See metaoutline.

OLAP model. See model.

online analytical processing (OLAP). A
multidimensional, multi-user, client server
computing environment for users who need to
analyze consolidated enterprise data in real time.
OLAP systems feature zooming, data pivoting,
complex calculations, trend analyses, and
modeling.

outline. See database outline.

RDBMS. Relational database management
system. A database that can be perceived as a set
of tables and manipulated in accordance with the
relational model of data.

relational attribute. A characteristic of a
dimension table, represented by a column. You
can run SQL statements against the data in
relational attribute columns.

relational database. A database that is
organized and accessed according to
relationships between data items. A relational
database contains a collection of relational tables,
views, and indexes.

report script. An ASCII file that contains Report
Writer commands that generate one or more
production reports. Report scripts can be run in
batch mode, using the ESSCMD command-line
interface, or through the Application Manager.
The script is a text file that contains data
retrieval, formatting, and output instructions.

restructure. An operation to regenerate or
rebuild the tables and views that DB2 OLAP
Server created in your relational database.

shadow. Information stored in relational tables
that shadows the information stored in a
multidimensional database outline.
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shared member. A member that explicitly
shares storage space with another member of the
same name. This member has an attribute that
designates it as shared. Shared members prevent
making extra calculations on a member that
appears in more than one location in a database
outline.

sibling. A child member at the same branch
level.

sparse dimension. A dimension with a low
percentage of available data positions filled. For
example, a product that is not sold in all of a
company’s available markets would be a good
sparse candidate.

Spreadsheet Add-in. Software that merges with
Microsoft Excel and Lotus 1-2-3 to enable
analysis of multidimensional databases. The
software library appears as a menu Add-In to the
spreadsheet and provides such features as
connect, zoom-in, and calculate.

SQL application. An application that uses SQL
statements. You can use SQL applications to
access data in a relational cube.

SQL. Structured Query Language. A
standardized language for defining and
manipulating data in a relational database.

star schema. The type of relational database
schema used by DB2 OLAP Server. When you
use the Application Manager to create a
multidimensional database, DB2 OLAP Server
creates a main fact table and a set of dimension
tables. The fact table holds the actual data values
for the database, and the dimension tables hold
data about members and their relationships.

star view. A relation view that DB2 OLAP
Server creates in your relational database that
allows an SQL user to access data from the star
schema in a single view with the JOIN already
done.

table space. An abstraction of a collection of
containers into which database objects are stored.
A table space provides a level of indirection
between a database and the tables stored within
the database. A table space:

v Has space on media storage devices assigned
to it.

v Has tables created within it. These tables will
consume space in the containers that belong to
the table space. The data, index, long field,
and LOB portions of a table can be stored in
the same table space, or can be individually
broken out into separate table spaces.

time dimension. A dimension type that defines
how often you collect and update data. You can
tag only one dimension as Time, although you
do not need to have a Time dimension.
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Contacting IBM

If you have a technical problem, please review and carry out the actions
suggested by the product documentation before contacting DB2 OLAP Server
Customer Support. This guide suggests information that you can gather to
help DB2 OLAP Server Customer Support to serve you better.

For information or to order any of the DB2 OLAP Server products, contact an
IBM representative at a local branch office or contact any authorized IBM
software remarketer.

If you live in the U.S.A., you can call one of the following numbers:
v 1-800-237-5511 for customer support
v 1-888-426-4343 to learn about available service options

Product Information

If you live in the U.S.A., then you can call one of the following numbers:
v 1-800-IBM-CALL (1-800-426-2255) or 1-800-3IBM-OS2 (1-800-342-6672) to

order products or get general information.
v 1-800-879-2755 to order publications.

http://www.ibm.com/software/data/db2/db2olap/
The DB2 OLAP Server World Wide Web pages provide current DB2
OLAP Server information about news, product descriptions, education
schedules, and more.

http://www.ibm.com/software/data/db2/db2olap/library.html
The DB2 OLAP Server Technical Library provides access to frequently
asked questions, fixes, books, and up-to-date DB2 technical
information.

Note: This information may be in English only.

http://www.elink.ibmlink.ibm.com/public/applications/
publications/cgibin/pbi.cgi The International Publications ordering
Web site provides information about how to order books.

http://www.ibm.com/education/certify/
The Professional Certification Program from the IBM Web site
provides certification test information for a variety of IBM products.

Note: In some countries, IBM-authorized dealers should contact their dealer
support structure instead of the IBM Support Center.
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